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1 GETTING STARTED 

1.1 UI CONVENTIONS 
The UI Conventions used in this document are meant to convey visually the information from the UI to 

the manual.  The following conventions are used is this manual: 

 Button (both dialog and ribbon): [OK] 

 Dialog label: Parameters 

 Context menu item: “Send to Viewer” 

 Tab label: File 

1.2 INSTALLATION AND LICENSING 
Installation of the IApioneer software is very simple.  Standard installer packages are available for MS 

Windows. Double click on the installer to launch the installation wizard, and follow the steps. 

Minimum System Requirements 

 Windows XP SP3, Vista, Windows 7 (32- or 64-bit), Windows 10 

 4 GB RAM 

 Core 2 Duo processor 

 7200 RPM hard drives 

 250MB Disk Space 

 OpenGL 2.1 supported graphics card* 

 Two-Button Mouse with a scroll wheel 

 

Recommended System Requirements 

 Windows 10 

 8 GB RAM 

 Core i5 processor 

 7200 RPM hard drives 

 1GB Disk Space 

 Graphics Card: NVIDIA graphics card 

 Two-Button Mouse with a scroll wheel 

                                                           
* GPU acceleration for some processes not supported on all graphics architectures 
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1.3 HOW TO CONTACT US 
Software support is available from IAVO Research and Scientific to assist with software technical issues.  

Before you contact us, please have the following information ready: 

 Company Name 

 Customer Number 

 Email Address 

 Product name and version 

 Computer O/S version 

 Error message, if any 

 Steps necessary to re-create the issue 

By e-mail: 

support@iavo-rs.com 

By phone: 

Direct: 919-433-2400 

Toll Free: 888-860-4286 

For more information, see http://iapioneer.com/support.html. 

1.4 SITE ADMINISTRATION FOR SETTINGS  
IApioneer provides a tool to configure the default settings for all users on a single computer.  The 

IApioneer Administrative Setup tool allows a site administrator to set the default settings for a given 

machine, and even lock/unlock certain fields to prevent users from overriding the site specific settings. 

To run the Site Administrative Setup tool, click on the Windows button, then go to the IApioneer 

software group.  Under IApioneer, choose to run Administrative Setup. 

Upon launch, the settings dialog will be displayed with the same layout and fields as the User Settings 

dialog within IApioneer (see User Settings).  Each field or group of fields can be set by the site 

administrator, and then locked.  Once locked (Figure 1), the user cannot override the field value with 

their own custom appearance.  If not locked, the user is free to specify their own settings for those 

fields. All of the User Settings for the main IApioneer application and any add-on modules can be 

configured in this manner. 

If more than one system at a site needs to have the same default site parameters specified, it is 

recommended that the site settings are configured on one system, then the settings file is copied to 

mailto:support@iavo-rs.com
http://iapioneer.com/support.html


 

IApioneer v. 3.0.5 Software User’s Manual – June 2017 [IAVO-TD-1009] Page 7 

 

each of the other systems.  That file can be found in the C:\ProgramData\IAVO Research and 

Scientific\GeoSPHERIC directory as the Preferences.dat file. 

 

Figure 1. The Site Administrative Setup tool, showing some locked parameters and some unlocked ones. 

  



 

IApioneer v. 3.0.5 Software User’s Manual – June 2017 [IAVO-TD-1009] Page 8 

 

 

1.5 USER INTERFACE (UI) 

1.5.1 ELEMENTS OF THE UI 
Figure 2 shows the components of the user interface. 

 

Figure 2. Components of the user interface, shown with the demo dataset loaded. 

1. The Ribbon – The tabs of the Ribbon organize capabilities by module, allowing the user to 

interact with the data in a logical manner.  The Home tab contains all of the camera and image 

viewing tools, including; zoom, rotation, brightness, contrast, and histogram adjustments.  Each 

of these is applied to the active viewer only.  In addition to the Home tab, each licensed 

processing module may add one or more tabs to the Ribbon. 
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2. Left Viewer – One of the two primary viewers used to interact with the data.  Images can be sent 

to the Left Viewer from the Image Gallery.  Data layers (vectors, tie points, and annotations) can 

be displayed from the Layer Manager. 

3. Right Viewer – One of the two primary viewers used to interact with the data.  Images can be 

sent to the Right Viewer from the Image Gallery.  Data layers (vectors, tie points, and 

annotations) can be displayed from the Layer Manager. 

4. Image Gallery –Thumbnails of the raster data loaded in the current session are displayed here.  

Images can be added to the Left or Right Viewers by right-clicking on the thumbnail in the Image 

Gallery and selecting “Send to Left Viewer” or “Send to Right Viewer”. 

5. Layer Manager – Vector, tie point, and annotation layers loaded in the current session are listed 

here.  Each has a checkbox to indicate whether or not it is displayed in the viewers, and a radio 

button to select the actively editable layer. The digital elevation model (DEM) used to support 

camera tracking and cursor location can also be set here. 

1.5.2 THE BACKSTAGE 
Data loading and system parameters are accessed through the Backstage (Figure 3), which can be 

brought up by clicking on the File tab in the Ribbon.  Here, you can load/remove data, save/open 

sessions, and access the Help and Settings for the application. 
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Figure 3. The Backstage, shown with the demo dataset loaded. 

The Session section of the Backstage lists all of the data currently loaded in the session.  It also has the 

ability to create new data layers (vectors, tie points, and annotations).  The data are organized by 

category: Images, DEMs, Vectors, Tie Points, and Annotations.  DEMs is a special form of raster image, 

where the pixel value corresponds to an elevation.  
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2 LOADING AND VIEWING DATA 
You can load several different types of data into IApioneer, including: satellite imagery, aerial imagery 

(scanned film and digital images), orthographic images, Digital Elevation Models (DEMs), 2D and 3D 

vectors, tie points, and annotations. 

2.1 LOADING DATA INTO THE SESSION 
To load data, go to the Backstage and select [Load Data]. Navigate to where your data is located and 

select the data that you wish to load into the session.  

As the data is ingested, it will be added to the data items in the Session section of the Backstage.  Raster 

data without pyramids (reduced resolutions, R-sets, etc.) will have the pyramids automatically 

generated for optimal viewing quality.  Until the pyramids have been generated, you will have minimal 

functionality for those images. Raster images with no pyramids generated will have a warning icon 

overlaid on the image icon in the Session data section. 

Note: Large datasets may take some time to load, especially large vector sets.  Be patient, as these will 

appear in the Session shortly. 

Alternatively, from the Windows Explorer, you can select one or more supported data types and drag 

them into an IApioneer viewer.  If only a single image is selected, that image will be loaded into the 

current session, and displayed in the viewer that it was dragged into.  If only a single data layer is 

selected (e.g., feature store, annotation layer, etc.) then that data layer file is loaded into the current 

session and made the active data layer for editing. If more than one file (raster or data layer) is selected, 

all supported files will be loaded into the current session. 

2.1.1 DATA DISCOVERY 
Instead of directly loading data into the Session, you can use the Data Discovery mechanism to crawl 

your local and remote data archives for data that meets your production criteria.  To use Data Discovery 

in your workflow, you must first specify the data repositories you wish to use.  You can do this in the 

Data Discovery section of the IApioneer settings (see Data Discovery Directories). 

Once the data repositories have been identified, the data discovery tool will crawl the directory 

structures, building a list of files and metadata for use in the Data Discovery process.  This may take 

anywhere from a few seconds to a few minutes, depending on how many files are in the repository. 

Go to the Backstage and select [Data Discovery] to launch the Data Discovery tool.  shows the Data 

Discovery tool with nearly 4000 files in the repository.  From here you can search by location, date, 

number of bands, sampling resolution, and obliquity angle.  The results are categorized by type of data, 

and then by subtype. You can also your data repositories based on geographic location. The visual data 
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coverage tool will display bounds of where your image is located in the world. You can then select within 

those bounds to see what images you have that covers that area.  

 

Figure 4. Data Discovery within a defined repository. 

Once the desired filters have been placed, use the checkboxes next to the found items to select data to 

load into the current Session.  Entire categories can be selected at once by checking the box next to the 

category name. Single items can be added or removed from the list by checking/unchecking the 

appropriate box.  Once all the data has been identified, press [Load] to ingest the selected data into the 

current Session. 

2.2 VIEWING RASTER DATA 
Once the data has been loaded into the current session, it can be sent to the viewers for visualization 

and exploitation.  Raster Data, once loaded, appear in the Image Gallery as a set of thumbnails (Figure 2, 
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area 4).  Other geospatial data (vectors, tie points, and annotations) appear in the Layer Manager 

(Figure 2, area 5).   

2.2.1 EXPLORING RASTER DATA 
Raster data can be loaded into the viewers by right-clicking on the thumbnail of the data in the Image 

Gallery and selecting “Send to Left Viewer” or “Send to Right Viewer”.  The image will be loaded into the 

chosen Viewer and a small arrow will appear in the bottom corner of the image thumbnail in the Image 

Gallery to indicate which Viewer the image is loaded in.   

You can pan the image by clicking and dragging with the center mouse button (the scroll wheel on many 

mice).  Free zooming can be performed by using the scroll wheel of your mouse.  Click into the desired 

Viewer to make it active, the roll the mouse wheel forward (away from you) to zoom out, and backward 

(toward you) to zoom in.  The zoom is centered on the viewer, allowing you to keep the region of 

interest centered at all times, no matter where the mouse cursor is. 

If you have no third mouse button or scroll wheel, you can pan by holding down both the left and right 

mouse buttons simultaneously and dragging.  Zooming can be performed using the fixed zoom intervals 

in the Home tab of the Ribbon.   

The divider between the Left and Right Viewers can be moved by clicking and dragging anywhere on the 

divider. 

2.2.2 THE HOME TAB VISUALIZATION TOOLS 
The Home tab (Figure 5) contains several visualization tools useful for interacting with the loaded data.   

The Display group contains tools for determining how the imagery is displayed, including options for 

Histogram adjustment, Brightness/Contrast, and Filters for removing noise and enhancing structure.  

There are also a number of overlays for context awareness, including display of the North arrow, 

geospatial grid lines, zoom ratio, overviews, and working regions.  For more information on these 

overlays, see Customizing the Viewer Display. 

 

 

Figure 5.  The Home tab contains visualization tools for data exploration. 

The Camera group contains tools for manipulating the position of the camera, including the zoom tools, 

jump to location, viewer linking, and movement modes.  [Camera Lock] is used to geographically link the 

viewers so that movement (pan and zoom) in one corresponds to movement in the other. The camera 
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movement mode can be selected as either [Pan Mode] (default) or [Roam Mode].  In the roaming 

mode, movement is accomplished by holding down the middle mouse button and dragging in the 

direction that you want the image to move. 

The Rotation group contains the tools to allow you to rotate the current view.  Free rotation can be 

performed by selecting [Compass] and using the slider to set the desired orientation.  There are also a 

few pre-determined rotation angles.  [Image Up] orients the image such that the columns of the image 

are aligned with the columns of the viewer.  [North Up] orients the image in the viewer so that the 

direction to North – as determined by the spatial reference system – is aligned with the columns of the 

viewer.  [Z Up] orients the image so that vertical changes in elevation (such as the vertical lines of tall 

buildings) are aligned with the columns of the viewer.  There are also quick rotate buttons to quickly 

rotate 90 degrees in either direction, or 180 degrees. 

The Source DEM allows the user to specify the DEM used for viewer-related processing, including 

Camera Lock and a number of exploitation and analysis tools.  The drop down allows the user to select 

any currently loaded DEM to use as the base DEM.  Alternatively, the No DEM Selection option uses the 

default low-resolution DEM included with the software. 

2.2.2.1 JUMP TO LOCATION 

The [Jump to Location] button in the Camera group on the Home tab provides the mechanism for you 

to center the active viewer on a specific geospatial or pixel location.  For geospatial coordinates, the 

coordinate templates for string input are controlled by the Display Format designated in the Geolocation 

Formats settings (see Geolocation Formats).  If the Elevation parameter is left blank, then IApioneer uses 

a DEM elevation lookup for the Jump To Location operation. Once valid locations have been entered, 

press [OK] to center the active viewer on the provided location. 

 

Figure 6. The Jump to Location dialog lets you center on a specific point. 

2.2.3 AUXILIARY VIEWERS 
Auxiliary Viewers provide the ability to communicate with the integrated applications capabilities. If you 

need more than two images for context awareness during processing, you can launch an image into an 

auxiliary image viewer. To display an image in the auxiliary viewer, right clicking on the image thumbnail 

in the Image Gallery and selecting “Open in New Viewer”.  A new image viewer will  launch with the 
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selected image loaded.  The auxiliary viewers also provide temporary annotations for use within several 

workflows, including third-party integrated tools. Please refer to the annotation management in Section 

7.3.2 for more information regarding annotations.  

Initiate temporary annotation mode in the Auxiliary Viewer by clicking on [Annotate]. This will suspend 

communication between the Auxiliary Viewer and the integrated tool (i.e., third-party tool will not 

receive mouse clicks, movement, etc.) and allow you to perform annotation and mensuration just as if 

you had created an annotation layer for permanent product generation. To pass control back to the 

integrated third-party tool, click [Annotate] once more to deselect the mode. 

2.3 VIEWING STEREO RASTER DATA 
Stereo pairs, once loaded into the session, can be loaded into a special viewer for stereo visualization. 

Stereo pairs can either be loaded into the stereo viewer manually, via the [Stereo Viewer] option on the 

Home tab, or automatically from a workflow such as the GWW workflows (see CGS Workflows). 

IApioneer uses the term “stereo pair” to define any pair of images that have been rectified so that both 

images have been projected onto a common image plane. This process yields an image pair where 

features along a row of one image also appear on a row in the second image. The shift in column values 

(horizontal shift) between the matching features is called parallax, or x-parallax, and enables 3D depth 

perception. In typical stereo image pair formation, corresponding points have identical vertical 

coordinates. However, in some image pairs, there is also a vertical parallax, or y-parallax component. 

Parallax is what determines the distance of an object from a projection plane, as seen in the images 

below. The case where the object is behind the projection plane is described as positive parallax, the 

projections of the object point are on the same side as the respective cameras. 

 

If an object is located in front of the projections plane, then the projection for the left camera is on the 

right, and the projection from the right camera is on the left. This is known as a negative horizontal 

parallax. 
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If the object lies on the projection plane, then both left and right cameras project onto the same point. 

This is the zero parallax case. 

 

Note: To visualize stereo image pairs in true stereo, your hardware must support stereo visualization 

and stereo must be turned on in your system and video driver settings. IApioneer provides Red/Blue 

anaglyph stereo functionality for those systems that do not have hardware stereo support. 

2.3.1 LOADING A STEREO PAIR INTO THE VIEWER 
To load a stereo pair into the viewer manually, select the [Stereo Viewer] option on the Home tab. This 

will launch the Stereo Selection dialog, as seen in Figure 7. IApioneer will use the images’ sensor models 

to automatically determine which image to use as the left and right image, but the user can specify the 

images to use at this time. Press [Open] to launch the stereo viewer. 
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Figure 7. Stereo Selection dialog with left and right images. 

2.3.2 USING THE STEREO VIEWER 
The Stereo Viewer has a limited subset of the same visualization tools found on the main viewers’ Home 

tab. There is one additional tool in the Display group of the Stereo Viewer, the [Swap Left/Right] option. 

If the left and right images specified when the Stereo Viewer was launched are in the wrong order, then 

the depth appearance of the scene will be inverted. High objects will appear sunken into the earth, and 

depressions will appear as mountains. To reverse this effect, use the [Swap Left/Right] option. 

Adjusting both the horizontal and vertical parallax is done with a combination of the mouse wheel and 

keyboard controls: 

 Horizontal Parallax Adjustment – To adjust the horizontal, or x-parallax, hold the Shift key while 

scrolling the mouse wheel. 

 Vertical Parallax Adjustment – To adjust the vertical, or y-parallax, hold both the Shift and Ctrl 

keys while scrolling the mouse wheel. 

2.4 VIEWING VECTOR, TIE POINT, AND ANNOTATION LAYERS 
Data layers are types of data that can be overlaid on top of imagery to provide additional exploitation 

capabilities.  Some IApioneer modules allow the creation and editing of data layers.  Clicking on [Layer 

Manager] in the Data Layers group on the Home tab expands the Data Layer Manager if it is not 

currently displayed, and hides the Data Layer Manager if it is already visible (Figure 8).  You can also click 

on the button of the divider between the Left Viewer and the Data Layer Manager to show/hide the 

Data Layer Manager.  The Data Layer Manager can be resized by clicking and dragging on the divider. 

New data layers can be added to the current session from the Data Layer Manager, by clicking on [Add 

Data Layers]. 

If you have a DEM image loaded in your session, you can set it as the active DEM used for cursor 

positioning and screen locking by selecting it from the Source DEM combo box.  

Each data item in the Data Layer Manager has both a checkbox and a radio button beside it.  The 

checkboxes indicate whether or not the data item is visible in the viewers.  The radio box indicates 

which data item is currently being edited.  Any number of data layers can be visible at once, but only 

one data layer can be edited at a time.   
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Note: To quickly hide all of the data layers, select [Hide All] in the Data Layers group on the Home tab. 

 

Figure 8. The UI showing the Data Layer Manager. 
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3 DATA MANAGEMENT 

3.1 SESSION MANAGEMENT 
The data loaded in the application is considered a Session.  IApioneer-based modules work on one 

Session at a time. IApioneer can save the state of your workspace for later processing using the [Save 

Session] or [Save Session As] functionality in the Backstage, accessed from the File tab.  The saved 

Session (*.xpj file) contains the references for the currently loaded data items, allowing for quick 

recovery of a previous set of data. 

Archived Sessions can be retrieved by selecting [Open Session] and navigating to the desired Session 

file. Alternatively, double-clicking on a *.xpj file in the Windows Explorer will open IApioneer (if it is not 

already open) and load the selected session file. 

Clicking on [Close Session] closes out the current Session, prompting you to save individual data items 

that have pending changes.  Once pending changes to individual items have been saved, you will be 

prompted to save the current Session before all items are removed and a new Session is created. 

3.2 RASTER IMAGE PROPERTIES 
To view or edit the properties of a raster image, go to the Session section on the Backstage, right click on 

the image that you wish to modify, and select “Properties”.  The Properties dialog has four tabs:  

 General – This tab contains information about the image itself, including basics such as file size, 

type, image dimensions, number of bands, and the type of image (Image or DEM).  It also has 

indicators as to whether or not the image has embedded metadata for spatial referencing 

information, affine transforms, or RPC sensor models.  Finally, it contains an estimate of the 

image GSD and its geospatial bounding box. 

 Metadata – This tab contains metadata tags embedded in image formats such as NITF. 

 Band Info – This tab provides information about the number of bands in the image, each band’s 

format, and a histogram estimate per band. 

 Sensor Model – This tab is where the user is able to view or set the sensor model information 

used for the photogrammetric calculations with each of the software processing modules.  

There are three sensor model formats supported: frame camera, RPC, and orthographic.   

Note: You can specify that an orthographic image is a DEM from the General Properties tab.  Click on the 

Image Type button to change an orthographic image from a raster Image to a DEM. 
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4 SETTING UP CAMERA SENSOR MODELS 
Most geospatial raster data have inherent metadata, which incorporates both the spatial referencing 

system that the data was acquired in, as well as the sensor model defining the projective nature of the 

image data.  IApioneer supports three sensor model formats: frame camera (scanned film and digital 

back), RPC, and orthographic.  Any image data loaded without embedded sensor model information will 

default to a unitary orthographic sensor model. 

To set/modify the sensor model for a raster image, go to the Session section of the Backstage and right-

click on the image.  Select “Properties”, and navigate to the Sensor Model tab of the Properties dialog. 

4.1 SPATIAL REFERENCE SYSTEMS 
A Spatial Reference System (SRS) is a coordinate-based system (local or global) that is used to locate 

geospatial data points.  A SRS consists of a Projection and a Datum.   

A Projection transforms the earth’s 3D surface into a flat (2D) representation at either a local or global 

level.  There are a number of projections in current use, but most are based on a conical, cylindrical, or 

azimuthal model. 

A Datum is a mathematical construct approximating the earth’s surface, allowing measurements to be 

made along the surface.  The most commonly used Datums are ellipsoidal, or geoidal in nature.  The 

ellipsoidal model approximates the surface as a 3D ellipsoid, as defined by a set of mathematical 

parameters.  An example would be the WGS84 ellipsoid.  A geoidal model uses a network of physical or 

derived measurements to define the 3D surface.  An example would be the EGM96 model. 

If you look at the same point using two different projections or datums, the geospatial coordinates of 

that point will differ.  Be sure to use the correct SRS parameters for your data to ensure accurate 

processing. 

4.1.1 CONFIGURING SPATIAL REFERENCE SYSTEMS 
All sensor models contain a Spatial Reference System that defines the map projection of the data.  For 

some data (e.g., RPC sensor models), the spatial reference system is an intrinsic one, whereas it needs to 

be explicitly assigned for other data.  For all raster data sensor models, the specification of the spatial 

reference system follows the same process.  Once the Sensor Type has been specified, select [Change] 

beside the Spatial Reference System identifier to configure the data’s spatial reference system. 

Figure 9 shows the Spatial Referencing dialog.  Here you can set the Projection, Datum, Linear and 

Angular Units, and the map projection Zone (as required).  Currently, there are a limited number of 

spatial reference systems that can be manually set in the application, though we ingest thousands of 

spatial reference systems through Well Known Text (WKT) strings. 
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Figure 9. The Spatial Referencing configuration dialog. 

Currently, the software supports the following manually selectable projections:  Latitude/Longitude, 

UTM, and State Plane.  Specifying either the UTM or State Plane projections also requires you to specify 

the appropriate Zone.  The geospatial Datums supported by the application are: WGS84, WGS72, 

NAD83, and NAD27.  The Linear and Angular unit options determine how the sensor model parameters 

are interpreted. To specify a custom spatial reference system, choose that option from the Projection 

drop-down, then copy a valid PROJCS WKT string into the text box at the bottom of the dialog. 

4.2 FRAME CAMERA SENSOR MODEL CONFIGURATION 
The Frame Camera sensor model consists of two primary sets of parameters, defining the interior 

orientation (IO) and exterior orientation (EO) parameters of the sensor as the image was acquired 

(Figure 10).  For the internal parameters, the user must have knowledge of the camera’s focal length 

and focal offset, and the internal affine representation of the sensor. If using a scanned film image, you 

will need to also have the sensor’s fiducial locations.  These are typically found in a camera calibration 

report.  Digital back images do not have fiducials, and their affine parameters are easily computed from 

the image dimensions and knowledge of either the sensor size, or the pixel size on the sensor.  In 

addition, radial distortion parameters can be provided. Exterior orientation parameters define the 

camera’s position and orientation at the time of acquisition, and are often provided in a text file 

containing the EO parameters of all the images acquired during a single flight/project.  Each of the 

parameters for the Frame Camera sensor model can be manually entered by the user. 
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Figure 10. Frame camera sensor model configuration. 

Once both the IO and EO parameters of the sensor have been set, press [OK] to apply the new sensor 

model.  In the Backstage, an asterisk will appear beside the dataset’s name, indicating that the metadata 

has changed.  The metadata must be saved for the changes to persist after the session has been closed 

out or the data has been removed from the current session. 

4.2.1 SCANNED FILM AFFINE PARAMETERS FROM FIDUCIALS 
Much of the imagery taken prior to 2005 was acquired on film and then digitized by means of a scanner.  

The affine parameters are therefore irregular.  The affine parameters can be computed from the sensor 

fiducial parameters and their measured locations on the image.  Selecting [Use Fiducials] launches the 

Fiducial Selection workflow.  This workflow walks you through the process of setting up the fiducial 

detection for the image.   

The first stage of the Fiducial Selection workflow (Figure 11) is where you set the sensor coordinates of 

the fiducials, and the orientation of the film on the scanner.  The sensor fiducial locations are typically 

found in a camera calibration report, such as that seen in Figure 12.  Select the radio button for the 

number of fiducials you were given in your calibration information, and enter the coordinates.  If you 

have a camera file (*.CAM) containing the fiducial information, you can load those values from that file. 

Note: The 4 Fiducials configuration option works for either “corners” or “cross” configurations – fiducials 

lying on the corners or the sides of the sensor, respectively. 
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Use the rotation arrows to change the orientation of the displayed image so that it appears “image up” 

in the display.  While doing so, you can use the scroll wheel to zoom in and out, and the left mouse 

button to pan around to help you set the orientation.  Once the fiducial coordinates and the scanner 

orientation has been set, click [Next] to proceed to the second stage.   

 

Figure 11. The first stage of the Fiducial Selection workflow, where you set the sensor’s fiducial coordinates. 
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Figure 12. Scanned in portion of a camera calibration report showing the principal point and fiducial locations. 

 

In between the first and second stages of the workflow, an auto-detection process is run to identify the 

locations of the fiducials in the image.  The second stage (Figure 13) shows you the result of the auto-

detection process on all the fiducials specified in the first stage.  If there are fiducials that were not 

correctly aligned with the image locations, you can manually edit their positions. 

Click on the thumbnail corresponding to the fiducial you wish to edit.  The sub-image will expand to give 

you a large canvas on which to locate the fiducial.  Click and drag the image to align with the fiducial 

mark.  You can zoom in and out to better find the precise location of the center of the fiducial marker on 

the image.  Click [Done] to finalize the position.  Repeat the process for any fiducials that need 

refinement. 

If you get too far off track, or wish to start over, click [Auto Detect] to re-run the auto-detection 

process.  Once the fiducial marks have been aligned, press [Finish] to compute and assign the affine 

parameters. 
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Figure 13. The second stage of the Fiducial Selection workflow, where you can confirm the fiducial alignment. 

 

4.2.2 DIGITAL AFFINE FROM SENSOR INFORMATION 
Images taken with a digital back (modern imagery) have no fiducials.  Instead, the affine is regular and 

can be computed directly from the sensor information; knowing either the sensor size or the size of a 

pixel is sufficient.   

Click [Digital Frame] to launch the Digital Frame Affine Calculation dialog.  Select the radio button for 

the parameter that you know, either Pixel Dimensions or Sensor Dimensions.  Enter the Width and 

Height for those parameters and select [OK] to set the digital affine. 
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Figure 143. The Digital Frame Affine Calculation dialog with pixels of size 12μm x 12μm. 

 

4.2.3 BATCH FRAME CAMERA SETUP 
 Aerial imagery is often acquired in large batches, either from a set of flight lines or from some other 

pre-specified flight path.  Manually editing each of the sensor models for these images would be quite a 

chore.  You can configure the sensor models for an entire batch of aerial imagery using the [Batch Aerial 

Workflow] option from the Backstage. 

The Batch Aerial Workflow will walk you through each of the steps for configuring the sensors models 

for a handful of images up to thousands at one time.  You simply follow the steps to set the fields for 

your cameras: internal parameters, external parameters, and data pairing parameters.  

The first stage of the Batch Aerial Workflow involves providing the IO parameters of the cameras.  This 

includes the focal lengths, focal offsets, distortion parameters, and internal affine information.  This 

information is provided with the camera calibration reports received with your data.  Make sure to 

choose the appropriate Sensor Affine model.  If you have images with fiducials, choose the Standard 

option.  For fully digital cameras, choose the Digital option. Figure 15 shows the first stage with the 

parameters for our test data entered.  Once the IO information is correct, press [Next] to continue. 
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Figure 15. First stage of the Batch Aerial Workflow, where you provide IO parameters. 

The second stage of the Batch Aerial Workflow is where you specify the exterior orientation parameters.  

These include the spatial reference system, the text file and containing the EO parameters, and the 

format of the text file. Figure 16 shows the second stage, with appropriate values for our test data.  

Once the information is correct, press [Next] to continue. 
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Figure 16. Second stage of the Batch Aerial Workflow, where you provide the EO parameters. 

It may happen that the Image IDs in the EO text file do not match exactly with the image names that you 

have loaded in your project.  Stage three of the Batch Aerial Workflow allows you to match the ID 

parameters in your EO text file with the appropriate images loaded into your project.  If the Image IDs 

do not match with the image files, simply select the drop down box next to each Image ID and choose 

the image it corresponds to.  Click [Next] to finish the workflow process and the software will 

automatically generate the sensor models for every image in your project. 

Once the process is complete, you should save the project.  This will save the metadata for the sensors 

you have just configured. 
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Figure 17. Third stage of the Batch Aerial Workflow, where you match loaded images with their Image IDs. 

4.3 RPC SENSOR MODEL CONFIGURATION 
Satellite imagery is typically delivered with its rigorous camera model information hidden behind a 

generic replacement sensor model in the form of RPCs.  RPC data are usually either embedded in the 

image file itself as metadata, or supplied via a secondary metadata file.  This information can be read 

from the external file, either by loading an IKONOS metadata file, or a standard RPC00B file (as seen in 

Figure 18). 

 

Figure 18. RPC sensor model configuration. 
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Once the RPC parameters have been set, press [OK] to apply the new sensor model.  In the Backstage, 

an asterisk will appear beside the dataset’s name, indicating that the metadata has changed.  The 

metadata must be saved for the changes to persist after the session has been closed out or the data has 

been removed from the current session. 

4.4 ORTHOGRAPHIC SENSOR MODEL CONFIGURATION 
Orthographic images (orthos) have been processed to remove perspective from the raster data so that 

each pixel falls on a point of a georeferenced grid.  An orthographic sensor model is defined by the 

geographic coordinates of its Upper Left Corner and the Post Spacing in both the X (horizontal) and Y 

(vertical) directions (Figure 19).  For most ortho images, the data has been processed so that traversing 

along a row of pixels corresponds to stepping along the X direction in the spatial reference system only, 

and traversing along the columns corresponds to stepping along the Y direction of the spatial reference 

system only.  However, it is possible that movement along either row or column can correspond to 

stepping both in the X and Y directions, geospatially.  This is referred to as a non-aligned ortho image. 

 

Figure 19. Orthographic sensor model configuration. 

Once the ortho parameters have been set, press [OK] to apply the new sensor model.  In the Backstage, 

an asterisk will appear beside the dataset’s name, indicating that the metadata has changed.  The 

metadata must be saved for the changes to persist after the session has been closed out or the data has 

been removed from the current session. 
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5 CUSTOMIZING THE VIEW 

5.1 CUSTOMIZING THE VIEWER DISPLAY 
The Display group in the Home tab contains a number of tools useful for adjusting how the selected 

image is displayed, as well as contextual overlays that can provide a better overview for exploitation. 

5.1.1 HISTOGRAM ADJUSTMENT 
Selecting [Histogram] launches the Color Curves dialog (Figure 20).  In this dialog, you can affect a color 

transform on individual channels, or all channels simultaneously, of the image in the active viewer.  

Output values from the color transform are scaled between 0 (black) and 1 (white).  A number of Presets 

are available for quick color transformations, including: 

 Piecewise Custom – Allows you to manually set the Input and Output values for the curve.  These 

can be set by manually clicking on a curve endpoint and dragging it to the desired position, or by 

manually entering the values in the text boxes below the curves. 

 Linear Min/Max – Sets the minimum image value to an output value of 0, and the maximum 

image value to a value of 1. 

 Linear 2% - Uses the histogram to scale the output between the 2nd percentile and 98th 

percentile of the image values. 

 Equalization – Transforms the input image histogram into a uniform distribution. 

 Gaussian – Transforms the input image histogram into a normal distribution. 

 

Figure 20. Color Curves dialog showing a Gaussian transformation. 
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As you are making changes to the color curves, the image in the active viewer will adjust according to 

your changes.  Selecting [OK] will fix those adjustments in place, while [Cancel] will revert to the last 

saved color curves. 

5.1.2 BRIGHTNESS, CONTRAST, AND FILTERS 
Use the [Brightness] and [Contrast] options to adjust the overall brightness and contrast of the image in 

the active viewer.  Clicking on one of the above options will open a gallery of preset choices, as well as a 

manual slider option at the bottom of the list. As changes are made, the active image will adjust 

accordingly to provide a preview of the changes. 

Use [Filter] to choose sharpening, smoothing, and haze reduction filters.  These filters are applied to the 

displayed data only, and can be used to quickly enhance the active image.  There are five options for 

quick filters: 

 Low Pass – This smoothing filter performs a low pass convolution on the data in the active 

image.  It uses a 5x5 smoothing kernel with normalized weights. 

 Gaussian Low Pass - This smoothing filter performs a low pass convolution on the data in the 

active image.  It uses a 5x5 smoothing kernel with Gaussian weights.  It provides less smoothing 

distortion than the Low Pass filter. 

 High Pass – This sharpening filter performs a high pass convolution on the data in the active 

image.  It uses a 5x5 convolution kernel with normalized weights. 

 Gaussian High Pass – This sharpening filter performs a high pass convolution on the data in the 

active image.  It uses a 5x5 convolution kernel with Gaussian weights. It provides less sharpening 

distortion than the Low Pass filter. 

 Haze Reduction – This combination of smoothing and sharpening filters provides local contrast 

enhancement and the removal of aerosol-like distortions in the image. 

5.1.3 IMAGE OVERVIEW 
[Image Overview] launches a small dialog with a thumbnail of the active image and a vector graphic that 

shows the current displayed bounds of the active image. 

5.1.4 NORTH ARROW, ZOOM INDICATOR, SCALE MARKER, AND GRID LINES 
The [North Arrow] option turns on/off a graphic depicting the direction to North in the current viewer.   

Use [Grid Lines] to turn on/off a map-coordinate grid overlay on the active image.  The map grid display 

parameters can be set in the Settings (see  
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Grid Lines).  

The [Zoom Ratio] button turns on/off the zoom indicator for the active viewer. 

The [Scale Marker] button turns the scale marker in the lower right corner of the viewer on/off. The 

scale marker’s appearance can be changed in the Settings. 

5.1.5 CURSOR INFORMATION 
[Cursor Information] in the Display group on the Home tab launches a dialog (Figure 21) showing the 

image (pixel) coordinates of the cursor, in addition to its projected map coordinates.  The projection 

coordinates are relayed based on the projection and display string formats specified in the Geolocation 

Formats settings.   Images that are chipped from larger sources have two sets of cursor location info; 

one for the chipped cursor location, and one for where that pixel would lie in the full image. 

 

Figure 21. Cursor Information dialog showing both full and chipped image pixel locations. 

5.2 USER SETTINGS 
To change the default settings for a variety of display and measurement operations within the UI, click 

on [Settings] in the Backstage.  The Settings dialog (Figure 22) allows you to specify how the UI displays 

certain types of information, including: measurement units, cursor information, display colors, fonts, 

and other graphics.  Unless locked by a Site Administrator (see Site Administration for Settings), the user 

settings can be changed to suit the customization desires of each individual user on a given system. 
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Figure 22. The Settings dialog. 

To change a setting, click on the setting type on the left tree and edit the parameters in the right hand 

side of the dialog.  Changes made to the preferences are saved on a per-user basis, allowing all users of 

a system to configure the look and feel of the software as they see fit. 

5.2.1 GEOLOCATION FORMATS 
The Geolocation Formats settings control how map information is displayed and entered (Figure 23).   

The Display Format controls how map coordinates are relayed to you in areas such as the Cursor 

Information dialog. The Display Format settings consist of a map projection, a string format, the vertical 

datum used for reporting elevation, and the units to measure elevation. 

 Projection Type – Specifies the map projection used.  Can be Native, Geographic, or UTM. 

o Native – The underlying projection of the source data 

o Geographic – Latitude/Longitude 

o UTM – UTM zone is defined by projection from the center of the source data’s bounds 

o MGRS – Military Grid Reference System 
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 Geographic String Format – Specifies the display string format as a decimal combination of 

degrees (DD), minutes (MM), and seconds(SS).  Only used if the Projection Type is Geographic. 

 Vertical Datum – Specifies the datum used to display elevation values.  Can be Ellipsoid(WGS84) 

or MSL (EGM96).  Value supersedes the datum used in the data’s SRS (for display purposes 

only). 

o Ellipsoid (WGS84) – Uses the WGS84 ellipsoid for reporting elevation values. 

o MSL (EGM96) – Uses the EGM96 geoid for reporting elevation values. 

 Vertical Units – Specifies the linear units used to report elevation values. 

 

Input Format provides the template for user-derived information, such as that provided in the Jump to 

Location dialog.  The input format consists of a map projection and string format. 

 Projection Type – Specifies the map projection used.  Can be Native, Geographic, or UTM. 

o Native – The underlying projection of the source data 

o Geographic – Latitude/Longitude 

o UTM – UTM zone is defined by projection from the center of the source data’s bounds 

 Geographic String Format – Specifies the display string format as a decimal combination of 

degrees (DD), minutes (MM), and seconds(SS).  Only used if the Projection Type is Geographic. 

 

Figure 23.  Changing the geolocation format settings. 

  



 

IApioneer v. 3.0.5 Software User’s Manual – June 2017 [IAVO-TD-1009] Page 36 

 

5.2.2 MEASUREMENT 
The Measurement settings control how all measurements are displayed to you throughout the 

application (Figure 24).  The measurement units can be specified for Length, Area, and Angles. 

 

Figure 24. Changing the Measurement settings. 
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5.2.3 DATA DISCOVERY DIRECTORIES 
The Data Discovery settings is where you can configure the locations of the source data to use with the 

Data Discovery Tool (see Data Discovery). 

 

Figure 25. Changing the Data Discovery settings. 
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5.2.4 TERRAIN 
The Terrain settings is where you can configure the application to look for DTED files to use as DEM 

sources (Figure 26).  You can specify locations for DTED0, DTED1, or DTED2 DEM files.  Use the up and 

down arrows to set the priority for the elevation files. 

The CGS workflows (see CGS Workflows) use these terrain directories for some of their computations.  

 

Figure 26. Changing the Terrain settings. 
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5.2.5 CGS GWW 
The CGS GWW settings allow the user to specify settings related to the CGS Geopositioning Workflow 

Wizard (Figure 27).  Select the root folder of the CGS application. 

 

Figure 27. Changing the CGS GWW settings. 
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5.2.6 PIXEL CURSOR 
Use the Pixel Cursor properties to specify the look of the measurement cursor (Figure 28).  The cursor 

has an Inner Color and an Outer Color, as well as a Size – Small, Medium, or Large. 

Note: For best visibility of the cursor, set the Inner Color and Outer Color to be highly contrasting. 

 

Figure 28. Changing the Pixel Cursor settings. 
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5.2.7 SCALE MARKER 
Use the Scale Marker settings to control the appearance of the scale marker (Figure 29).  The scale 

marker segments, color, and orientation can all be adjusted. 

 # of Segments – Number of alternating segments for the Scale Marker. 

 Marker Width – Width, in pixels, of the Scale Marker. 

 Primary Color and Secondary Color – Set to contrasting colors for best visibility. 

 Orientation – Choose between Horizontal, Vertical, and Both (L-shaped) orientations for the 

Scale Marker 

 

 

Figure 29. Changing the Scale Marker settings. 
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5.2.8 DISPLAY 
Use the Display settings to configure default parameters for the viewers (Figure 30).  Currently, the only 

configurable parameter is the Image Orientation, which can be set to one of the primary rotation angles 

in the Home tab. 

 Image Up orients the image such that the columns of the image are aligned with the columns of 

the viewer.   

 North Up orients the image in the viewer so that the direction to North – as determined by the 

spatial reference system – is aligned with the columns of the viewer.   

 Z Up orients the image so that vertical changes in elevation (such as the vertical lines of tall 

buildings) are aligned with the columns of the viewer.   

 

Figure 30. Changing the Display settings. 
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5.2.9 GRID LINES 
The appearance of the geospatial grid overlay found on the Home tab can be configured through the 

Gridlines settings (Figure 31).  The Line Color and Line Style can be configured, as well as the Line Weight 

and other drawing parameters for the Major and Minor Axis. 

 

Figure 31. Changing the Gridlines settings. 
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5.2.10  ROI 
The ROI settings can be used to change the default appearance of the region of interest, as accessed 

through the Home tab (Figure 32).  You can specify the Line Color, Line Weight, and Line Style here. 

 

 

Figure 32. Changing the ROI settings. 
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6 EXPORTING YOUR DATA 
IApioneer is capable of exporting a number of data types for easy ingestion into other utilities.  Both 

raster data and vector data can be exported, for a variety of product delivery types. 

6.1 CROP, RESAMPLE, AND REPROJECT RASTER DATA 
The primary mechanism for exporting raster data is the Crop, Resample, and Reproject dialog (Figure 

33).  This dialog is accessed from the Backstage by right-clicking on the raster image that you wish to 

export and selecting the “Crop, Resample, and Reproject” option. 

The Crop, Resample, and Reproject dialog allows the user to chip a sub-image from the original raster 

data.  The bounds of the chipping process can be set to pixel values, either by click-dragging a 

highlighted rectangle in the image thumbnail, or by specifying the pixel locations in the dialog itself.  

Alternatively, the user can crop the image based on geospatial coordinates by selecting [Use Geospatial 

Coordinates].  From that dialog (Figure 33), the user can specify the Spatial Reference System used as 

the base map projection, and the bounding coordinates of the sub-image.   

A third option is to define the sub-image boundaries from another geospatial data item, by clicking 

[From Other Data].  The Geospatial Data Selection dialog allows the user to select another data item as 

the basis for the chip boundaries, as well as a buffer around that data, if desired. 

Checking the Resample box allows you to specify the nominal GSD (spatial resolution) of the output 

image.  Here you can specify the Resolution and Linear Units. 

You can change the output spatial reference system for Orthographic sensor models only by selecting 

the Reproject checkbox and setting the output spatial reference system.  This changes the base map 

projection for the output sub-image 

Once the chipping parameters have been specified, selecting the Filename and output format for the 

sub-image is the final step.  Pressing [OK] kicks off the chipping process.  When complete, the generated 

sub-image will be added to the current session. 
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Figure 33. The Crop, Resample, and Reproject dialog allows you to export sub-images. 

 

 

Figure 34. Select chip boundaries from geospatial 
coordinates. 

 

 

Figure 35. Select chip boundaries from another data item. 
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6.2 RASTER DATA TYPE CONVERSION 
Raster data can be converted from one data type (float, int, etc.) to another.  This is accomplished by 

right-clicking on the raster data item in the Session section of the Backstage and choosing “Data 

Conversion”.  Data conversion  allows you to convert raster data from one Data Type (Byte, Short, 

Unsigned Short, Int, Unsigned Int, Float, Double) to another, as seen in Figure 36. This is a batch process, 

meaning that multiple images can be processed at a time by selecting them in the Backstage and 

launching the dialog on the group.  The user selects the output Data Type and File Format from the 

dropdown boxes, the output filename – or output directory plus suffix for multiple images – and kicks 

off the conversion process by selecting [Run].  Once the process is complete, the generated items will be 

added to the current session. 

 

Figure 36. The Data Conversion dialog allows the user to convert from one data type to another. 

6.3 EXPORT RASTER DATA 
Rich-clicking on a single (or multiple) raster item(s) in the Backstage and selecting the “Export” option 

will launch the Export Images dialog (Figure 37).  Here, you can export the selected images as they are, 

changing only the File Format, as desired.  This is another batch operation dialog, where multiple images 

can be processed at a time by selecting them in the Backstage and launching the dialog on the group.  

The user selects the output File Format from the dropdown boxes, the Output Filename – or Output 

Path plus Suffix for multiple images – and kicks off the conversion process by selecting [Run].  Exporting 

imagery is typically only used to convert file formats for use in other applications, but the user can 

choose to add the generated items to the current session by selecting the Add Results to Project 

checkbox. 
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Figure 37. The Export Images dialog provides the ability to export an image in a different file format. 

  

6.4 REGION OF INTEREST AND IMAGE CHIPPING FROM VIEWERS 
Often, you want to indicate a working area, or deliver a portion of the image identified in the active 

viewer.  This can be an actual image chip, or simply a JPEG graphic to use for a briefing.  IApioneer 

provides several mechanisms for identifying ROIs and using them in production scenarios. 

6.4.1 REGION OF INTEREST 
You can specify a ROI from the Product Generation tab by clicking the [Region of Interest] gallery and 

choosing “Set Region of Interest”.  This allows you to rubber band select (click and drag) a ROI in the 

active viewer.  The ROI can be hidden (or shown again, once hidden) by clicking on the [Region of 

Interest] button itself.  The appearance of the ROI is controlled via the ROI settings (see Customizing the 

View, User Settings,  ROI).  

The ROI can be used in product delivery to designate a working region, or for image chipping. 

6.4.2 IMAGE CHIPPING 
The Image Chip functionality in the Screen group of the Product Generation tab provides a shortcut to 

the Crop, Resample, and Reproject dialog (see Crop, Resample, and Reproject Raster Data), with the 

crop boundaries pre-set to either the current view, or to the current ROI. 

You can chip the image in the active Viewer to the bounds of the current ROI by clicking on the [Image 

Chip] gallery, and selecting “Chip from ROI”.  The Crop, Resample, and Reproject dialog will be launched, 

with the bounding image coordinate pre-set to align with the current ROI. 
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Likewise, selecting “Full Screen Chip” from the [Image Chip] gallery launches the Crop, Resample, and 

Reproject dialog with the bounding image coordinates pre-set to align with the current viewing bounds 

of the active Viewer. 

6.4.3 SCREEN CAPTURE 
You can save the active Viewer (and its contents) by selecting the [Screen Capture] option in the Screen 

group of the Product Generation tab.  The screen capture mechanism stores all of the visible information 

in the active Viewer for ingestion into other products, such as a PowerPoint briefing. 

The “Save Screen to File” option from the gallery copies the active viewer’s contents to a flat image file, 

such as a JPG, PNG, BMP, or similar. 

“Save Screen to PowerPoint” copies the active viewer’s contents to the clipboard, and then opens a new 

PowerPoint presentation, pasting the viewer’s contents into the new presentation.  This mechanism 

requires Microsoft PowerPoint 2007 or newer to be installed on the system.  

“Copy Screen to Clipboard” sends the contents of the active viewer to the system clipboard, where it can 

be pasted into other applications for product generation. 

The “Copy ROI to Clipboard” option copies only the contents of the active ROI to the system clipboard. 

6.5 EXPORTING VECTOR DATA 
Vector data can be exported in a variety of formats for archival and ingestion into other data processing 

packages.  Go to the Backstage and right-click on the vector data item you wish to export.  Choose the 

“Export” option to launch the vector Export dialog. 

The Export dialog allows the user to export the selected vector file, with options for output format, 

projection, texturing, and more (Figure 38).  The Output Format parameter includes the most common 

geospatial 2D and 3D file formats, including: 

 GeoVector (IAVO proprietary) 

 ESRI Shapefile 

 Presagis OpenFlight 

 Collada 

 KML/KMZ 

 Wavefront OBJ 

 PLY 

 XYZ point set 

 Common Data Base (CDB) 
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The Reproject Data checkbox is used to convert the vector file’s spatial reference system from the 

original to one of your choosing.  Click [Change] to specify the output spatial reference system. 

Output formats that include texture information can have automatic texturing  applied to the data by 

checking the Include Textures checkbox.  With that option checked, click [Change] to specify which 

images will be used to automatically texture the data.  The automatic texturing process takes into 

account camera look angle, spatial resolution, and occlusions to identify the best texture patches for 

every polygon in the dataset.   

Complete the operation by selecting the Output Filename and pressing [Export]. 

 

Figure 38. The Vector Export dialog allows the user to export 2D and 3D vector data in a variety of formats. 

 

6.5.1 EXPORTING MULTIPLE VECTOR FILES AS A SINGLE KMZ 
Often, 3D site models are developed in parts by multiple members of a modeling team.  These parts are 

typically stored in separate files for editing and display, but need to be exported into a single file for 

distribution.  Multiple 3D vector models can be exported into a single KMZ file by selecting two or more 

vectors in the backstage, then right-clicking and following the export process for KMZ files detailed 

above. 
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7 IAPIONEER ANALYSIS 

7.1 WHAT IS IAPIONEER ANALYSIS? 
IApioneer Analysis is a module of the IApioneer family of geospatial processing applications. It is used 

for imagery exploration, exploitation, analysis, and annotation.  Specifically, the Analysis module is 

focused on product annotation and delivery, allowing the user to generate annotated products that can 

be delivered in the form of PowerPoint briefings, chipped datasets, and other single-layer export 

process.  These annotation overlays can be saved and distributed as viewable layers to anyone with 

IApioneer. 

IApioneer Analysis offers the capability to: 

 Annotate imagery with text boxes, point markers, and simple geometry 

 Measure length, area, and azimuth values with a few mouse clicks 

 Capture screenshots of annotated products 

 Save annotations for future use and distribution to other IApioneer users 

 Use intuitive drawing mechanisms to develop sophisticated products 

7.2 ANNOTATION LAYER MANAGEMENT 
Annotation Layers are individual documents within IApioneer, and are listed in the Session section of the 

Backstage, under the Annotations heading.  From the Backstage, Annotation Layers can be created, 

saved, and loaded.  New Annotation Layers can also be created directly from the Home tab of the 

ribbon, or from the Data Layer Manager. 

When working with Annotation Layer data, use the Data Layer Manager to specify the active Annotation 

Layer for editing and viewing. 

7.2.1 CREATING AN ANNOTATION LAYER 
Click [Add Annotation Layer] in the Session section of the Backstage to create a new annotation layer.  

The new Annotation Layer will be added to the session as an Unnamed Annotation Document, ready for 

editing or saving.  To change the Annotation Layer’s name, save it (see Saving Vector Layers).  The new 

filename will become the Annotation Layer’s display name. 

Alternatively, Annotation Layers can be created directly from the Home tab of the Ribbon.  Click on the 

[Add Layer] dropdown and choose the Add Annotation Layer option.  The same mechanism is in place in 

the Layer Manager. 

Whichever method is used to create an Annotation Layer, the new layer is set as the active layer for 

immediate editing. 
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7.2.2 SAVING ANNOTATION LAYERS 
Right click on an Annotation Layer in the Backstage and choose “Save Data” or “Save Data As” to save 

the Annotation Layer for future processing. The file will be saved in a *.gad format, which is an XML-

based IAVO internal file format. 

 Save Data – Allows you to store the Annotation Layer.  If there is no file currently associated 

(i.e., a new Annotation Layer) you will be prompted to provide a filename.  That filename will 

become the name of the Annotation Layer. 

 Save Data As – To prevent you from overwriting the original document, the Save Data As 

command stores the current Annotation Layer in a new document. 

7.2.3 LOADING ANNOTATION LAYERS INTO THE SESSION 
Ingestion of Annotation Layers is the same as ingestion of raster data (or any other data type).  Use the 

[Load Data] option in the Backstage, and point the file dialog to the annotation data file(s) you wish to 

load. 

7.3  EDITING AN ANNOTATION LAYER 
With IApioneer, you can edit Annotation Layers, as well as create and view them.  Although annotations 

are typically drawn on a reference image, they are anchored geospatially, and thus can propagate across 

multiple images.  It is important to note that unless the data is perfectly registered, annotations drawn 

on one reference image may be slightly off (visibly) when overlaid on any other image. 

7.3.1 ANNOTATION VISIBILITY AND SETTING THE ACTIVE LAYER 
The first step in editing an Annotation Layer is the set it as both visible, and the active layer for editing, 

using the Layer Manager.  Figure 39 shows the IApioneer module with the Data Layer Manager visible 

and a single Annotation Layer ready for editing.  Clicking on [Layer Manager] in the Data Layers group 

on the Home tab expands the Data Layer Manager if it is not currently displayed, and hides the Data 

Layer Manager if it is already visible.  You can also click on the button of the divider between the Left 

Viewer and the Data Layer Manager to show/hide the Data Layer Manager.  The Data Layer Manager 

can be resized by clicking and dragging on the divider. 

Each Annotation Layer in the Layer Manager has a checkbox and a radio button to the right of its name.  

The checkbox indicates visibility – checked means that the layer is visible in the Viewers.  The radio 

button indicates the active (editable) layer.  Module tabs appear in the ribbon, based on the type of the 

active layer.  When the active layer is an Annotation Layer, the Analysis module tab appears in the 

Ribbon. 
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Figure 39. IApioneer Analysis module with an Annotation Layer loaded. 

 

7.3.2 ADDING SHAPES AND CLIPART 
The Analysis tab contains two groups of tools for annotations and measurements.  The Insert group 

allows you to insert single shapes and MIL-STD-2525B clip art.  The types of shapes supported i include 

basic shapes – points, lines, and polygons – as well as complex items such as text boxes, point markers, 

and target rings.  Initial parameters for the appearance of the annotation objects are pulled from the 

defaults settings (see IApioneer Analysis User Settings IApioneer Analysis User Settings). 

The drawing objects in the IApioneer Analysis toolset are modal in nature.  Once the drawing object 

mode has been selected (e.g., Polygon), new objects can be repeatedly drawn by holding the CTRL 

button and left clicking to start the new object.  The object can then be drawn as detailed below. 

Polygon – Select “Polygon” from the [Polygon] drop down.  Click on the image in the location of the first 

point of the polygon.  Continue clicking to set the vertices of the polygon.  The last selected point will 

always be attached to the first point, closing the polygon.  Once the last vertex has been placed, right-

click to finish drawing.  
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Rectangle – Select “Rectangle” from the [Polygon] drop down.  Click on the image in the location of the 

upper left corner of the rectangle and drag the cursor to define the rectangle.  Release the left mouse 

button to finalize the shape. 

Ellipse – Select [Ellipse].  Click on the image in the location of the upper left corner of the ellipse’s 

bounding box and drag the cursor to define the ellipse.  Release the left mouse button to finalize the 

shape. 

Point – Select [Point].  Click on the image in the location of the point to draw the shape. 

Polyline – Select [Line].  Click on the image in the location of the first point of the polyline.  Continue 

clicking to set the vertices of the polyline.  Once the last vertex has been placed, right-click to finish 

drawing. 

Text Box – Select [Text Box].  Click on the image in the location of the center point of the text box.  A 

text box will be placed in the image and the text highlighted for easy text entry. Click outside of the text 

box to finalize the annotation. 

Point Marker – Select [Point Marker].  Click on the image in the location of the point marker to draw 

the shape.  A small circle will be drawn, indicating the location of the point.  In addition, a text box will 

be drawn attached to the point, indicating the geospatial coordinates of the point marker. 

Targeting Circle – Select [Targeting Circle].  Click on the image in the location of the point to draw the 

shape.  A set of target rings will be drawn around the selected point, along with a text box indicating the 

geospatial coordinates of the center of the target rings.   

North Arrow – Select [North Arrow].  Click on the image in the location of the point to draw the shape.  

Unlike other clip art-style graphics, which maintain their orientation with respect to the viewer as the 

image is rotated – the North Arrow graphic always indicates the direction of True North for images with 

the appropriate support data. 

Clip Art – Clip art can be added as graphic annotations to the image through the use of the Clip Art 

dialog.  Click on [ClipArt] to launch the dialog.  (Note: Currently, IApioneer only supports the Warfighting 

symbols from the MIL-STD 2525B graphics objects.) 

To place a graphics object from the library of images, navigate the tree structure to find the desired 

graphic.  As the tree is navigated, the contents of the library folders are previewed in the graphic pane 

to the right.  When the desired graphic has been found, click on the preview icon in the right pane and 

drag the icon into the image viewer.  Release the left mouse button to drop the graphic into the viewer, 

centered at the point of release. 
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Note: The Clip Art dialog is a persistent dialog that defers to the primary application for window 

placement.  If you click on the Clip Art button and the dialog does not launch, check to see if it is open 

“behind” the application. 

7.3.3 ADDING LINEAR AND ANGULAR MENSURATION ANNOTATIONS 
The Inspect/Measure group of the IApioneer tab provides tools for linear and angular measurement. 

Initial parameters for the appearance of the annotation objects are pulled from the defaults settings 

(see IApioneer Analysis User Settings). 

Separation Angle – Click [Separation Angle] to begin measuring an angle in the image.  Begin by clicking 

on an endpoint of the angle.  Then, click the pivot vertex of the angle, and finish by clicking on the other 

angle endpoint.  As the cursor moves to the final position, the angle measurement between the first line 

segment and the one joining the pivot point to the cursor is continually displayed, allowing the user to 

view a number of angle measurements before finally selecting the last point. 

Length – Click [Length] to begin measuring a length in the image.  Begin by clicking on the starting point 

of the line segment and finish by clicking on the endpoint.  As the cursor moves to the final position, the 

length measurement is continually displayed, along with the change in elevation, allowing the user to 

view a number of length measurements before finally selecting the last point. 

7.3.3.1 HEIGHT 

The Height tools allow the user to create a line segment to measure the height of an object in an image. 

There are three methodologies to calculating the height of an object: 

Shadow Tip to Object Top - Click [Shadow Tip to Object Top] to begin measuring the height of the 

object by its shadow. Left click the shadow tip and then left click the object top in that order. The height 

of the object is calculated in real-time as the cursor moves within the image. The image must have the 

image acquisition date and time to calculate using the shadow methods. 

Object Base to Shadow Tip - Click [Object Base to Shadow Tip] to begin measuring the height of the 

object by its shadow. Left click the object base and then left click the shadow tip in that order. The 

height of the object is calculated in real-time as the cursor moves within the image. The image must 

have the image acquisition date and time to calculate using the shadow methods. 

Object Base to Object Top - Click [Object Base to Object Top] to begin measuring the height of the 

object. Left click the object base and then left click the object top in that order. The height of the object 

is calculated in real-time as the cursor moves within the image. This method can be performed on any 

non-orthographic imagery to calculate the height. 
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7.3.4 ADDING A BUFFER ZONE AROUND A SET OF ANNOTATIONS 
The buffer tool will allow you to create a visual indicator of an encroachment zone around a specific 

object. You will need to select the group of annotation objects that you would like to define a region 

around. Select Buffer from the Inspection/Measure group on the Analysis tab. This will display a dialog 

(Figure 40) that will provide you the ability to specify the parameters (Buffer Style and Buffer Radius) of 

the buffer.  

There are three methods for creating the buffer around the selected polygons: 

 Convex hull of all objects – Finds the convex hull of all selected objects, and then builds the 

buffer out from that.  The buffer will be a single convex polygon with no holes. 

 Union of individual convex hulls – Computes the convex hull of each selected polygon, and then 

performs a union operation to combine overlapping hulls. The resulting set of polygons is then 

used to build the buffer. The buffer may be more than one polygon, and may contain holes. 

 Union of individual shapes – Computes a union of the selected objects, then builds the buffer 

from the resulting polygons. Because no convex hulls are generated, the buffer will follow the 

contours of the objects more closely.  
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Figure 40. Using the Facility Buffer tool to identify regions around selected polygons. 

After you have defined the properties and you are satisfied with the buffer displayed in the active 

viewer, click OK within the Facility Buffer Tool. The facility buffer polygons will be added to the active 

Annotation Layer as new annotations.  

Note: Once created, the buffers will not be attached to the source polygons in any way.  Moving the 

original shape will not also move the buffer, unless both are selected. 

7.3.5 USING THE COUNTING TOOL 
The Counting Tool (Figure 41) provides the ability to keep a running tally of objects in the image. You can 

add multiple counting icons to keep track of different objects in the scene.  

Click on the Plus icon to add a new counting marker. With the counting tool active, clicking in the viewer 

will place a marker at that location, and increase the current count for that marker. You can add 

multiple markers to count different types of objects by clicking again on the plus sign.  

To remove a marker that has already been placed, make the desired marker set active, and then click on 

the Eraser to enter the correction mode.  Click on the desired marker to remove it from the tally. Once 
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the desired correction has been made, click on the Eraser again to exit the correction mode. An entire 

set of counting markers can be deleted by clicking on the corresponding X to the right hand side of the 

marker list. 

 

Figure 41. The Counting Tool provides visible markers and a running tally of counted objects. 

7.3.6 EDITING ANNOTATIONS 
IApioneer provides a limited capability to edit annotations once they have been initially drawn.  Most of 

the annotation objects can be moved by clicking anywhere on the annotation and dragging it to its new 

location.  The exceptions are Point Markers and Target Circles, which only allow their text boxes to be 

moved. 

To edit the vertices of a polygon, once placed, right click on the selected polygon and choose “Edit 

Points”. Click and drag a highlighted vertex to move it.  When the editing is complete, double click 

outside of the selection to finalize the new geometry. 

It is possible to subdivide any convex polygon with four sides (convex quadrilateral), into regularly 

sampled subregions by right-clicking on the polygon and choosing “Subdivide”.  The Subdivide Polygon 

dialog allows you to specify the number of Rows and Columns of the subdivision, dynamically updating 
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the annotation in the Viewer to provide immediate feedback on the final appearance.  Pressing [Apply] 

deletes the original annotation and replaces it with the subdivisions, each as a separate annotation 

object.  The subdivision annotations’ properties are copied from the parent annotation. 

 

Figure 42. Polygon annotation subdivision. 

7.3.7 EDITING THE TEXT IN A TEXT BOX 
Double click inside any text box annotation (or the text box of a complex annotation object) to edit the 

text.  Type the new text, including carriage returns, and click outside the text box to finalize the changes. 

7.3.8 VIEWING AND EDITING ANNOTATION PROPERTIES 
Each annotation object has a set of properties that contain appearance parameters for its geometry and 

textboxes, as well as mensuration information.  Some annotations may contain one, two, or even all 

three of these sets of parameters.  Default parameters for each of these parameters are pulled from the 

Settings, but you can change these properties for individual annotations.  These properties can be 

accessed by right-clicking on the annotation and choosing the “Properties” option. 
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7.3.8.1 MENSURATION PROPERTIES 

The Details tab in the Annotation Properties dialog gives you metrics about the selected annotation.  

These include Area, Perimeter, and Centroid information.  The units used for reporting here are drawn 

from the Measurement default settings. Figure 43 shows an example of the mensuration properties for 

a polygon annotation. 

 

Figure 43. The Mensuration properties of a polygon annotation. 

7.4 IAPIONEER ANALYSIS USER SETTINGS 
To change the default settings for the annotation objects in IApioneer, click on [Settings] in the 

Backstage.  The Analysis group in the Settings dialog is where the defaults for each of the annotation 

objects reside. 

To change a setting, click on the setting type on the left tree and edit the parameters in the right hand 

side of the dialog.  Unless locked by a Site Administrator (see Site Administration for Settings), the user 

settings can be changed to suit the customization desires of each individual user on a given system. 
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7.4.1 FOOTPRINTS 
The Footprints settings control how DPPDB footprints are displayed in the viewer (Figure 44).  You can 

specify the Line Color, Line Style, and Line Weight for both the Controlled Footprint and the Uncontrolled 

Footprint of a DPPDB segment.  

 

Figure 44. Changing the Footprints settings. 
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7.4.2 MENSURATION TOOLS 
The Mensuration Tools settings control how mensuration annotations appear (Figure 45).  You can 

specify the default look and feel of the mensuration tools by specifying the Font parameters and Effects, 

as well as the Foreground and Background colors for the text.  You can also specify the Line Properties of 

the mensuration vector components. 

 

Figure 45. Changing the Mensuration Tools settings. 

 

  



 

IApioneer v. 3.0.5 Software User’s Manual – June 2017 [IAVO-TD-1009] Page 63 

 

7.4.3 Point 

The Point settings control how point annotations appear (Figure 46).  You can specify the default Color, 

Weight, and Style for the Point annotation. 

 

 

Figure 46. Changing the Point annotation settings. 
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7.4.4 Point Marker 

The Point Marker settings control how the point vector appears (Figure 47) for the point marker 

annotation.  You can specify the default Color, Weight, and Style for the marker annotation. You can also 

specify the Font parameters and Effects, as well as the Foreground and Background colors for the text.   

 

 

Figure 47. Changing the Point Marker annotation settings. 
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7.4.5 Polygon 

The Polygon settings control how polygon annotations appear (Figure 48).  You can specify the default 

look and feel of the polygon annotations by specifying the Line Properties of the vector components.  

Alternating, or candy-cane, colors can be specified in the Line Style options. You can also specify 

whether the Show Endpoint Direction and Show Centroid parameters are initially checked.  The Fill Color 

can also be specified here. 

 

Figure 48. Changing the Polygon annotation settings. 
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7.4.6 Polyline 

The Polyline settings control how polygon annotations appear (Figure 49).  You can specify the default 

look and feel of the polyline annotations by specifying the Line Properties of the vector components.  

You can also specify whether Show Endpoint Direction is initially checked.   

 

Figure 49. Changing the Polyline annotation settings. 
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7.4.7 Target 

The Target settings control how target circle annotations are initially constructed (Figure 50).  You can 

specify the Marker Color for the annotation object delineating the center of the target annotation.  

Here, you can also specify parameters for the default rings, including the Damage Ring Units, and the 

initial Radius and Colors for the ring annotations. You can also specify the Font parameters and Effects, 

as well as the Foreground and Background colors for the text.   

 

 

Figure 50. Changing the Target annotation settings. 
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7.4.8 Textbox 

The Textbox settings (Figure 51) control the Font, Effects, and Color parameters for both standalone 

textbox annotations, as well as textboxes that appear as a component in complex annotations (e.g., 

point markers, target rings).  The Line Properties are used for both the textbox border, as well as any 

necessary callout lines for complex annotations. 

 

 

Figure 51. Changing the Textbox annotation settings. 
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8 FEATUREXTRACT 

8.1 WHAT IS FEATUREXTRACT? 
FeatureXTract is a module of the IApioneer family of geospatial processing tools.  It is used for 2D and 

3D modeling and feature extraction, with simplified tools for identifying features in overlapping 2D 

images and modeling them in 3D space.  All you need is two or more overlapping images, with support 

data, to easily extract points, edges, and polygons to create accurate 3D scenes of roads, buildings, and 

more. 

FeatureXTract offers the capability to: 

• Perform geospatially accurate 3D modeling from overlapping satellite and aerial imagery  

• Streamline the feature extraction process through draw and match technology 

• Rapidly extract 3D buildings and roads 

• Export feature layers for use in GIS applications 

• Export textured features to Presagis, Google Earth for use in visual simulation applications or 

editing 

• Automatically texture map the extracted scenes 

8.2 VECTOR LAYER MANAGEMENT 
Vector Layers are individual documents within FeatureXTract, and are listed in the Session section of the 

Backstage, under the Vectors heading.  From the Backstage, Vector Layers can be created, saved, and 

loaded. 

When working with Vector Layer data, use the Data Layer Manager to specify the active Vector Layer for 

editing and viewing. 

8.2.1 CREATING A VECTOR LAYER 
Click [Add Vector Layer]  in the Session section of the Backstage to create a new vector layer.  The new 

Vector Layer will be added to the session as an Unnamed Feature Set document, ready for editing or 

saving.  To change the Vector Layer’s name, save it (see Saving Vector Layers).  The new filename will 

become the Vector Layer’s display name.  

Alternatively, Vector Layers can be created directly from the Home tab of the Ribbon.  Click on the [Add 

Layer] dropdown and choose the Add Vector Layer option.  The same mechanism is in place in the Layer 

Manager. 

Whichever method is used to create a vector layer, the new layer is set as the active layer for immediate 

editing. 
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8.2.2 SAVING VECTOR LAYERS 
Right click on a Vector Layer in the Backstage and choose “Save Data” or “Save Data As” to save the 

Vector Layer for future processing. The file will be saved in a *.gvf format, which is a binary IAVO 

internal file format. 

 Save Data – Allows you to store the Vector Layer.  If there is no file currently associated (i.e., a 

new Vector Layer) you will be prompted to provide a filename.  That filename will become the 

name of the Vector Layer. 

 Save Data As – To prevent you from overwriting the original document, the Save Data As 

command  stores the current Vector Layer in a new document. 

 Export – Allows you to save the data in a number of different file formats.  

8.2.2.1 VECTOR DATA EXPORT 

Choosing “Export” launches the Export dialog (Figure 52), where you can specify the Output Format.  

Depending on the format chosen, you may be able to Reproject Data, Include Textures, or Center the 

Data at the Origin. 

 

Figure 52. The vector data Export dialog allows you to save your vector data in a number of common output formats. 

 

Reproject Data allows you to transform the vertices of the selected vector dataset from one spatial 

reference system to another. 

For output formats that support texturing, checking the Include Textures checkbox allows you to specify 

the textures used for automatic texturing of the data.  Click [Change] beside the Include Textures listing 

to specify the textures used for the automated texturing process.  In the GeoData Selection dialog, select 

the images to use for texturing and hit [OK].  When the export process is run, each polygon in the vector 
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data set will be textured with the “best” texture segment pulled from the selected images, based on a 

number of criteria including: best camera angle, highest resolution, and minimal occlusions. 

Choose the Center Data at Origin option for those file formats that are designed to be used with data 

centered about the origin (0,0,0). 

Once your options have been set, provide an Output Filename, and click [Export] to run the export 

process.  This process can be lengthy for large datasets with textures. 

8.2.3 LOADING VECTOR LAYERS INTO THE SESSION 
Ingestion of Vector Layers is the same as ingestion of raster data (or any other data type).  Use the [Load 

Data] option in the Backstage, and point the file dialog to the vector data file(s) you wish to load. 

8.3 EDITING A VECTOR LAYER 
With FeatureXTract, you can edit Vector Layers, as well as create and view them. It is important to note 

that unless the data is well registered, features extracted between one pair of images may not align 

exactly with another pair.  

Whether you are extracting planar features from orthographic images, or 3D features from overlapping 

imagery, FeatureXTract depends on the underlying elevation source.  There are three primary elevations 

sources that FeatureXTract draws from.  In order (least priority to highest) they are: the low resolution 

DEM provided with the FeatureXTract install, user-provided DTED, and a user-specified DEM.  The best 

choice, if you have it available, is to load a high resolution DEM into the application, and specify it as the 

working Source DEM in the data layer manager.  Alternatively, in the Settings section of the Backstage, 

you can specify a directory location for local or network DTED data.  Finally, if no other source of 

elevation can be found, FeatureXTract is deployed with a low resolution elevation model of the earth. 

The command actions Copy (CRTL-C), Paste (CTRL-V), and Undo (CTRL-Z) are available during the vector 

editing process. 

8.3.1 VECTOR LAYER VISIBILITY AND SETTING THE ACTIVE LAYER 
The first step in editing a Vector Layer is to set it as both visible and as the active layer for editing, using 

the Layer Manager.  Figure 53 shows the FeatureXTract module with the Data Layer Manager visible and 

a single Vector Layer ready for editing.  Clicking on [Layer Manager] in the Data Layers group on the 

Home tab expands the Data Layer Manager if it is not currently displayed, and hides the Data Layer 

Manager if it is already visible.  You can also click on the button of the divider between the Left Viewer 

and the Data Layer Manager to show/hide the Data Layer Manager.  The Data Layer Manager can be 

resized by clicking and dragging on the divider. 

Each Vector Layer in the Layer Manager has a checkbox and a radio button to the right of its name.  The 

checkbox indicates visibility – checked means that the layer is visible in the Viewers.  The radio button 
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indicates the active (editable) layer.  Module tabs appear in the ribbon, based on the type of the active 

layer.  When the active layer is a Vector Layer, the FeatureXTract module tab appears in the Ribbon.  

You can have any number of data layers loaded and visible, but only one data layer can be edited 

(active) at a time. 

 

 

Figure 53. FeatureXTract module with a vector layer loaded and ready for editing. 

8.3.2 CREATION TOOLS 
The FeatureXTract Creation group contains the basic geometries used to extract complex 2D and 3D 

features from the imagery.  The types of geometries supported include: polygons, points, polylines, and 

circles. The creation tools are modal, meaning that one creation mode is active at all times.  This allows 

you to quickly draw many items of the same geometry without having to return to the Ribbon. 

For all geometries, except points, the drawing process is similar.  Begin by holding the CRTL key and left-

clicking to set the initial point.  Release the CTRL key and continue to left click each vertex of the 

geometry you are modeling. When you have placed the last point, right-click to finalize the shape. 
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Note: Mis-click a point?  You can use the Backspace key to remove the last vertex you placed.  Or, if you 

wish to start completely over, use the ESC key. 

Polygon – There are two types of polygons that are available from the Polygon gallery: Polygon, and 

Box.  A Box is a special form of Polygon where all the sides of the geometry are parallel or perpendicular 

to the first drawn segment.  Alternatively, you can hold down the CTRL key while drawing a standard 

Polygon and force the newest line segment to be perpendicular to the last drawn line segment.  All 

Polygons are closed shapes, where the last vertex placed is always connected back to the first placed 

vertex. 

Ellipse   – There are two types of ellipses available from the Ellipse gallery:  Ellipse, and Circle. An Ellipse 

is drawn by placing 5 points anywhere on its perimeter.  A Circle is drawn by placing three points 

anywhere on its perimeter.  

Point – To draw a Point, CTRL-click to place the point in the image. 

Line – The Line object can be used to draw single line segments, or joined segments as a polyline.  

Don’t want to hit CTRL to start every geometry? 

Instead of starting every new geometry with a CTRL-click, you can use the mouse to initiate a new 

geometry.  Simply click on the geometry type in the Ribbon and then begin clicking your vertices. 

8.3.3 MANIPULATION TOOLS 
The FeatureXTract Manipulation group contains the tools necessary to convert the drawn geometries to 

accurate 3D shapes by visibly aligning the geometries in the images. Making 3D models is simply a 

matter of drawing the shapes in one image, and then visibly aligning them in another.  The available 

manipulation actions are: epipolar, z-axis, freehand, and rotation.  Like the Creation tools, the 

Manipulation tools are modal, with one Manipulation mode active at all times. 

Move Epipolar – Clicking and dragging objects when the Epipolar movement mode is active restricts 

movement to the epipolar line defined by the relationship between the sensor models of the images in 

the Left and Right Viewers.  This is the primary manipulation mode used to model in 3D between two 

images.  By drawing the geometry in one Viewer and moving it along the epipolar line in the other 

Viewer until it aligns with the imagery, you can accurately place the geometry in 3D space. 

 Move Z-Axis – Clicking and dragging objects when the Z-Axis movement mode is active restricts 

movement to the local z-axis, as defined by the data’s spatial reference system.  

Move Freehand – Clicking and dragging objects while the Freehand movement mode is active restricts 

the movement to the local X-Y plane (keeping the z values constant), as defined by the data’s spatial 

reference system. 
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Rotate – Clicking and dragging objects while the Rotate mode is active rotates the selected objects 

around the local z-axis.   

8.3.4 DETAILING TOOLS 
The FeatureXTract Detailing group contains tools to add 3D details to existing geometries.  The available 

detailing actions are: polygon extrusion, feature lofting, roof building, and reversing the selected face 

normal.  Unlike the Creation and Manipulation tools, the Detailing tools are single-use operations that 

act on a selected object or group of objects. 

Extrude Polygon(s) – Extrudes the selected polygon(s) to the underlying elevation source (3D model, 

user-specified DEM, DTED, or embedded DEM). 

Planar Extrusion – All points in the polygon are extruded to the same elevation value, the 

lowest point of extrusion. 

Extrude by Point – Each point is extruded separately, with each lying on the first intersected 

surface. 

Loft Feature – Loft a selected polygon to a point, or another polygon of the same topology (number of 

sides).  Use the Loft action to generate any conic form, such as: cone (circle to point), pyramid (polygon 

to point), truncated cone (circle to circle), or truncated pyramid (polygon to polygon).  Combine lofting 

with Rotation and Freehand movement to add twist and skew to your conics. 

Reverse Face – Sometimes in the creation process, your face normals may be reversed from how you 

intended to draw them.  Use this tool to reverse the directions of the selected faces. 

Mesh Convert – Provides conversion from a set of polygons to a Mesh object, or from a Mesh object to 

a set of polygons.  The parameterized structures in the Roof and Structures gallery and the Model 

Library both use Mesh objects. 

Split Edge –Splits the selected edge by adding a new vertex in the center of the line segment. 

Combine Shapes – Provides the ability to create complex shapes by adding or subtracting simple shapes 

from each other. 

Union – Combines any number of 2D shapes into a single 2D shape. 

Subtraction – Subtracts one shape from another. 

Roofs and Structures – This gallery contains a set of parameterized structures, each based on an 

underlying feature type.  
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8.4 BUILDING A SIMPLE MODEL 
Let’s start by constructing a simple 3D model of a rectilinear building with a simple superstructure.  First, 

create a new vector layer and then make it the active layer for editing (see Creating a Vector Layer and 

Vector Layer Visibility and Setting the Active Layer).  Next, load overlapping imagery into the Left and 

Right Viewers.  Navigate to a simple rectangular building, such as that seen in Figure 54.  

On the FeatureXTract tab, select the Creation mode as Polygon.  Draw the outline of the roof (the gutter 

line) in the Left Viewer by CTRL-clicking the first point, and then clicking on each vertex of the gutter 

line.  Once the last point has been placed, right-click to finalize the shape.  In the Right Viewer, the 

shape will be projected, based on the elevation drawn from the elevation source specified – DTED or a 

Source DEM, if you specified that in the Settings or from the Source DEM on the data layer manager; the 

default elevation model, if not.   

Set the Manipulation mode to Move Epipolar.  In the Right Viewer, click on the polygon and drag it along 

the epipolar line until the shape aligns with the building’s gutter line in the Right Viewer (Figure 54).  

Once the shapes are aligned in both images, the polygon has been accurately located in 3D space.   

Next, click [Extrude Polygon(s)] in the Detailing group.  The selected polygon will be extruded to the 

underlying elevation source to provide a 3D structure. 
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Figure 54. Set the 3D location of the polygon by visually aligning it in both images. 

To add the superstructure, repeat the process above, outlining the perimeter of the superstructure.  

When the superstructure is extruded, the base of the structure is lying on the terrain.  However, we 

want the base to lie on top of the building, not on the terrain.  Set the Manipulation mode to Move Z-

Axis.  Click on the base of the extruded superstructure.  Because there are multiple overlapping polygons 

at the location where the cursor was clicked, the Select Feature dialog (Figure 55) will appear.  All the 

features lying beneath the cursor appear in the selection dialog, in order of elevation – the lowest 

elevation sources are on the bottom of the list, with features having the highest elevation on the top of 

the list.  Selecting a feature in the list highlights the feature in the Viewers. Press [OK] to select the 

feature.  Once the bottom feature has been selected, click and drag inside the feature to raise the 

elevation until it is aligned with the bottom of the superstructure in the image, as seen in Figure 56. 

Note: Multiple features can be selected by holding Shift and repeatedly launching the Select Features 

dialog. 
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Figure 55. The feature selection dialog. 

 

 

 

Figure 56. 3D building model with superstructure. 
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8.5 BUILDING MORE COMPLEX MODELS 
Using the same principles as Constructive Solid Geometry (CSG), where complex solids are built using 

binary operations on simpler primitives, you can build complex 3D site models in FeatureXTract using a 

combination of simple tools.  For example, a water tank could be represented by a cylindrical body and 

conical top.  We can model a water tower by combining the cylinder and cone, along with the stanchions 

and supporting elements. 

8.5.1 USING THE LOFT TOOL TO CREATE CONICS 
Cones, pyramids, and the truncated forms of these shapes can be easily created using the Loft Feature 

tool in the Detailing group of the FeatureXTract tab.  This allows us to rapidly create common geometry 

that would be difficult to create by hand.   

For example, the cone of the building in Figure 57 was created by drawing a circle on the top of the 

superstructure, followed by a point to represent the tower tip, and moving the shapes along the 

epipolar lines to set the 3D locations.  Then, drag-select the two shapes and press [Loft Feature].  

FeatureXTract will automatically connect the vertices of the base polygon (circle) to the point to form 

the cone.  This same process can be performed with any base polygon to form a polygonal pyramid. 

 

Figure 57.  Loft a circle to a point to create a cone. 
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Many roof types are in the form of truncated pyramids.  For example, see the main roof of the building 

in Figure 58.  Create the polygons representing the lower and upper roof lines, and move the shapes 

along the epipolar lines to set their 3D locations.  Select both shapes and press [Loft Feature] to form 

the truncated pyramid roof.  

 

Figure 58. Loft a polygon to another polygon to create a truncated pyramid. 

 

8.5.2 USING THE SNAPPING TOOL FOR COMPLEX GEOMETRY 
The roof shape in Figure 58 can be also be generated using the snapping tool.  The snapping tool (SHIFT) 

allows you to connect new geometry to existing vertices, and is one of the primary mechanisms used for 

complex geometry creation.  To begin, start as in the previous example, by drawing the upper and lower 

rooflines and using the epipolar manipulation to set their 3D locations.   

Next, hold both CTRL and SHIFT and move the mouse cursor to the lower left corner of the lower (larger) 

roof polygon. The CTRL button is used to initiate the drawing process, while the SHIFT button signals the 

snapping mechanism.  When the mouse cursor is near – within 5 pixels – an existing vertex, the cursor 

will “snap” to the vertex location.  Clicking while “snapped” sets the new drawing point to the existing 

point, thereby locking the new geometry and the old geometry together.  Release the CTRL key, and 

move to the lower left corner of the upper (smaller) polygon.  When the cursor is moved more than 5 

pixels from the existing vertex, it will move freely, until moved within 5 pixels of another vertex.  Click on 

the new vertex while snapped to set the second point.  Continue around the roof section to the upper 

left corner of the upper roof polygon, and then to the upper left corner of the lower polygon.  When the 
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last point has been placed, right-click to finalize the shape.  You can repeat this process for each of the 

four roof segments, as seen in Figure 59. 

 

Figure 59. Using the snapping tool to build a roof structure by sections. 

Hint: Preserve your outward-facing normal by placing vertices in a counter-clockwise (right hand rule) 

order 

8.5.3 USING BOOLEAN GEOMETRY TO COMBINE SHAPES 
The concept of Boolean geometry abounds in manmade structures, and support the basic premise of 3D 

FeatureXTract – that you can model complex shapes using combinations of simple structures.  For 

modeling purposes, we define this concept in the Combine Shapes tools. 

Figure 60 shows the process of creating a pill shape by combining a quadrilateral with a pair of circles 

using the Union operator from the [Combine Shapes] gallery.  The Union operator uses the Boolean 

formula A + B + C + … to combine any number of simple 2D shapes into a single polygon.  

 

Figure 60. Combining multiple shapes using Boolean geometry. 
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Figure 61 shows the process of subtraction, where one shape is removed from another, using the 

Subtraction operator from the [Combine Shapes] gallery.  This reflects the space carving approach of 

reducing simple geometries to form more complex ones.  The Subtraction operator uses the Boolean 

operation A – B to remove one 2D shape from another.  There is a limitation that disallows any resulting 

geometry with a hole in it. 

 

Figure 61. Using Boolean subtraction to carve complex shapes. 

8.5.4 USING PARAMETERIZED STRUCTURES 
There are a number of parameterized structures you can use as a shortcut to geometry creation.  3D 

FeatureXTract has the capability to build gable, saltbox, hipped, pyramid, parapet, gambrel, mansard, 

cylindrical vault, pitched vault, and dome type roofs from base polygons. All of these are built upon base 

polygons.  Walls can be built from a base polyline. 

The output of a parameterized structure dialog is a Mesh object.  This is a single object whose vertices 

cannot be individually edited, unless it is converted to a set of polygons using the [Mesh Convert] 

process.  The parameters for the Mesh object are stored with it, allowing you to edit them after 

creation.  To edit the parameters once the Mesh object has been created, select the Mesh and then 

select the appropriate parameterized structure from the gallery.  The dialog will be populated with the 

current parameters, which you can then edit. 

8.5.4.1 CREATING GABLED AND HIPPED ROOF VARIANTS 

Figure 62 shows how to create a pitched roof from a rectangular roof gutter line by selecting the base 

rectangle and choosing “Hipped Roof” from the parameterized structures gallery in the Detailing group.  

Set the Roof Axis to match the orientation of the pitched roof ridgeline.  Then, set the Height parameter 
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to adjust the height of the roof until the preview geometry aligns with the roof geometry in the imagery 

(as seen in Figure 62). Use the Ridgeline Offset to account for any offset of the axis from the center line.  

If your pitched roof has vertical ends – also known as a gabled roof – you are done.  However, if all sides 

of your pitched roof slope downward, you have a hipped roof.  Creating the hips in 3D FeatureXTract is 

straightforward.  If both hips appear to be the same, use the Lock Hip Values checkbox.  Adjust the Left 

and Right Hip values until the preview geometry aligns with the imagery. Press [OK] to finalize the 

geometry. 

 

Figure 62. Creating a hipped roof from a base polygon. 

8.5.4.2 CREATING PARAPET ROOFS 

Figure 63 shows how to create a parapet roof from a roof gutter line by selecting the base polygon and 

choosing “Parapet Roof” from the parameterized structures gallery in the Detailing group.  Set the 

Width to match the observed width of the parapet.  Then, set the Depth parameter to adjust the height 

of the parapet. Press [OK] to finalize the geometry. 
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Figure 63. Creating a parapet roof from a base polygon. 

8.5.4.3 CREATING GAMBREL AND MANSARD ROOFS 

Mansard and Gambrel roofs have multiple pitch slopes, leading to a common centerline.  3D 

FeatureXTract has quick access to each of these through the parameterized structures library.  Figure 64 

shows how to create a mansard roof from a rectangular roof gutter line by selecting the base rectangle 

and choosing “Mansard Roof” from the parameterized structures gallery in the Detailing group.  Set the 

Roof Axis to match the orientation of the pitched roof ridgeline.  Then, set the Peak Height parameter to 

adjust the height of the roof until the preview geometry aligns with the roof geometry in the imagery. 

Set the Ridge Length to match the ridgeline geometry in the image. The Curb Offset and Height 

parameters describe the falloff of the second slope. Press [OK] to finalize the geometry. 



 

IApioneer v. 3.0.5 Software User’s Manual – June 2017 [IAVO-TD-1009] Page 84 

 

 

Figure 64. Creating a mansard roof from a base polygon. 

8.5.4.4 CREATING VAULTED ROOFS 

3D FeatureXTract has two different parameterized vaults for quickly adding these structures to your 

scene.  The barrel vault (barracks, Quonset) is essentially a half-cylinder laying on its side.  A pointed 

vault lofts the structure to a peak.  Both vault roof types are constructed in a similar fashion. 

Creating a barrel vault (barracks, Quonset) roof from a base polygon follows a similar process to that of 

the pitched roof creation (Figure 65). Select the base polygon, and then choose “Barrel Vault” from the 

parameterized structures gallery in the Detailing group.  Set the Roof Axis to match the orientation of 

the pitched roof ridgeline.  Then, set the # Slices parameter to match the amount of geometry 

refinement you wish to have in the final geometry.  More slices mean a smoother roof, but also more 

geometry to manipulate and texture.  Once the number of slices has been set, use the Height parameter 

to adjust the height of the roof until the preview geometry aligns with the roof geometry in the imagery. 

Press [OK] to finalize the geometry. 
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Figure 65. Creating a cylindrical roof from a base polygon. 

8.5.4.5 CREATING DOMES 

You can easily create a dome from a circular feature by using the “Dome” option from the 

parameterized structures gallery in the Detailing group (Figure 66).  Set the # Layers parameter to 

specify the geometry refinement desired.  Then, set the Height parameter to match the preview 

geometry to the imagery. Press [OK] to finalize the geometry. 
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Figure 66. Creating a dome from a circle base. 

8.5.4.6 CREATING WALLS AND FENCES 

Walls and fences can be created from a line feature by using the “Wall” option from the parameterized 

structures gallery in the Detailing group, as seen in Figure 67.  Set the Height parameter to match the 

preview geometry to the imagery. Press [OK] to finalize the geometry.  Then, set the width to match the 

width of the wall. Side to Build Off describes the side of the measured line to use to build out the wall.  

Side A and Side B reflect the “left” and “right” sides of the line, while Split builds the wall using the 

measured line as a centerline for the wall.  Fence uses the measured line as a centerline, and sets the 

Width to 0.  Once the parameters have been set, press [OK] to finalize the geometry. 
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Figure 67. Creating a wall from a line base. 

8.6 USING THE 3D VIEWER 
The 3D Viewer is a useful tool for examining your created FeatureXTract output, and for performing 

Quality Assurance on the fly. To launch the 3D Viewer, click on [Show 3D Viewer] in the Home tab of the 

Ribbon.  The 3D Viewer is launched as a new viewer, and has its own controls.  The 3D Viewer displays 

the active Vector Layer (Figure 68). Each time a new vector layer is loaded into the 3D Viewer, it is 

displayed from above. 
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Figure 68. The 3D Viewer, viewing a vector layer from above. 
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8.6.1 3D VIEWER NAVIGATION 
The 3D Viewer navigation controls are similar to those of most flight simulators. 

Note: If you get lost in the navigation, and set the camera to a viewpoint where you cannot find the 3D 

scene you are editing, use the [View Extents] option in the Home tab of the 3D Viewer Ribbon to reset 

to the default overhead view. 

Zooming In and Out – Zoom into the current scene by rolling the scroll wheel up (away from you). Zoom 

out of the current scene by rolling the scroll wheel down (toward you). 

Looking Around – Click and drag with the left mouse button to grab a point in the scene and move it. 

The 3D point that was clicked on tracks the mouse cursor as it moves. 

Camera Rotation – Click and drag with the right mouse button to rotate the camera about the current 

viewpoint. 

Fixed Elevation Panning – Click and drag with the center mouse button (or scroll wheel) to pan the 

camera around the scene at a fixed elevation and camera angle. 

Flythrough – Hold down the left and right mouse buttons simultaneously to move forward along the 

current look angle.  Move the mouse to change the look angle and fly direction.  Moving the mouse 

forward (away from you) causes the camera to look down, and moving it backward (toward you) causes 

the camera to look up.  While flying, holding the SHIFT key speeds up the movement by 500%. 

8.6.2 REAL-TIME VISUALIZATION 
With the 3D Viewer active, you can visualize your 3D geometry creation and editing in real-time, 

providing a valuable resource for accurate and timely modeling, as well as in-process Quality Assurance. 

Figure 69 shows the 3D Viewer as ne geometry is being created.  The top cylinder is resting on the 

bottom one, and there is no air gap, as evidenced by inspection in the 3D Viewer. 
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Figure 69. Using the 3D Viewer to visualize geometry creation in real-time. 

 

8.7 COMBINING IT ALL TOGETHER 
Combining these concepts together, it is simple to create large-scale 3D site models from overlapping 

imagery.  Figure 70 shows a compilation of hundreds of structure models covering the entire downtown 

Durham, NC area, all modeled in FeatureXTract.  You can export the final model into a number of 

formats, including textured KML (KMZ), as seen in Figure 70 (see Vector Data Export).  
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Figure 70. 3D site model containing hundreds of structures. 
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Figure 71. Exported textured KMZ site model shown in Google Earth. 
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9 PRODUCT GENERATION 
This section will provide you the capability to interact with other applications to produce application 

specific outputs, export what is in the active viewers or just start creating a product template from 

scratch or modifying an existing template with the template editor.  

9.1 TEMPLATE EDITOR 
You are provided the ability to create a new template or modify an existing template with the template 

editor. The output will be a template overlay that can be used in the CGS workflows. Figure 72 shows 

the Template Editor with a blank template loaded.  

 

Figure 72. The IApioneer product template editor. 
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9.1.1 CREATING A NEW TEMPLATE 
You can create a new blank template from within the template editor. Click the [New] button from 

within the template tab. A Save Changes dialog will display asking you to save your previous template. 

The templates are only retrievable if you save the template. All of your work will be lost if you do not 

save the progress from within the current template. The width and the height properties are used to 

define the size of the template in pixels. You can manipulate the size of the template by the width and 

height properties. 

9.1.2 EDITING AN EXISTING TEMPLATE 
You are also equipped with the ability to edit an existing template. Click the [Open] button to locate the 

template you would like to edit. A Save Changes dialog will display asking you to save your previous 

template. The Open dialog will display, allowing you to find the template file you would like to modify. 

Select the template file and click the [Open] button to load the template into the template editor.  

9.1.3 SAVING AN EXISTING TEMPLATE 
You are also equipped with the ability to save an existing template. The templates are only retrievable if 

you save the template. All of your work will be lost if you do not save the progress from within the 

current template. Click the [Save] button to save the current template. The Save As dialog will display, 

allowing you to save the template file to a location with a unique name. Click the [Save] button to save 

the template.  

9.1.4 INSERTING ANNOTATIONS 
The Template tab contains a group of tools for annotations.  The Insert group allows you to insert single 

shapes.  The types of shapes supported includes basic shapes – points, lines, and polygons – as well as 

complex items such as text boxes, point markers, and targeting circles.  Initial parameters for the 

appearance of the annotation objects are pulled from the defaults settings (see IApioneer Analysis User 

Settings). 

The drawing objects in the IApioneer Analysis toolset are modal in nature.  Once the drawing object 

mode has been selected (e.g., Polygon), new objects can be repeatedly drawn by holding the CTRL 

button and left clicking to start the new object.  The object can then be drawn as detailed below. 

Polygon – Select “Polygon” from the [Polygon] drop down.  Click in the template on the location of the 

first point of the polygon.  Continue clicking to set the vertices of the polygon.  The last selected point 

will always be attached to the first point, closing the polygon.  Once the last vertex has been placed, 

right-click to finish drawing.  

Rectangle – Select “Rectangle” from the [Polygon] drop down.  Click in the template on the location of 

the upper left corner of the rectangle and drag the cursor to define the rectangle.  Release the left 

mouse button to finalize the shape. 
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Ellipse – Select [Ellipse].  Click in the template on the location of the upper left corner of the ellipse’s 

bounding box and drag the cursor to define the ellipse.  Release the left mouse button to finalize the 

shape. 

Point – Select [Point].  Click in the template on the location of the point to draw the shape. 

Polyline – Select [Line].  Click in the template on the location of the first point of the polyline.  Continue 

clicking to set the vertices of the polyline.  Once the last vertex has been placed, right-click to finish 

drawing. 

Text Box – Select [Text Box].  Click in the template on the location of the center point of the text box.  A 

text box will be placed in the image and the text highlighted for easy text entry. Click outside of the text 

box to finalize the annotation. 

Point Marker – Select [Point Marker].  Click in the template on the location of the point marker to draw 

the shape.  A small circle will be drawn, indicating the location of the point.  In addition, a text box will 

be drawn attached to the point, indicating the geospatial coordinates of the point marker. 

Targeting Circle – Select [Targeting Circle].  Click in the template on the location of the point to draw 

the shape.  A set of target rings will be drawn around the selected point, along with a text box indicating 

the geospatial coordinates of the center of the target rings.   

North Arrow – Select [North Arrow].  Click in the template on the location of the point to draw the 

shape.  Unlike other clip art-style graphics, which maintain their orientation with respect to the viewer 

as the image is rotated – the North Arrow graphic always indicates the direction of True North for 

images with the appropriate support data. 

Figure 73 shows a sample template created for the CGS precision point mensuration process. 
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Figure 73. Six-point target product template created using the Template Tool. 
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9.2 CGS WORKFLOWS 
As the ELT for the CGS Workflow, IApioneer directly integrates with the Common Geopositioning 

Services (CGS) Workflows. CGS is a software program that is not distributed with IApioneer.  

Note: The CGS workflows may ask IApioneer to provide the terrain directories used for some of its 

computations. These can be set in the Terrain settings of the IApioneer application (see Terrain 

settings). If these directories are empty, CGS may not run, or may yield unexpected results. 

9.2.1 GEOPOSITIONING WORKFLOW WIZARD 
The Geopositioning Workflow wizard is part of the CGS application. IApioneer will assist you by 

performing the ELT capabilities for the CGS application. You will be able to initiate the use of CGS with a 

single click of the [Geopositioning Workflow Wizard] button on the Product Generation tab within 

IApioneer. The CGS application will load displaying the CGS application. Please refer to the CGS User 

Manual to complete the wizard. 

WARNING: The first time the Geopositioning Workflow Wizard is launched, go to the 

Tools>Preferences… There, select the Display Options from the Preferences tree on the left side of the 

dialog. Make sure that the Multipanel Loading option is not checked. Click on the OK button to save 

changes, then close and relaunch the workflows. 

9.2.2 AIMPOINT VERIFICATION 
The Aimpoint Verification is part of the CGS application. IApioneer will assist you by performing the ELT 

capabilities for the CGS application. You will be able to initiate the use of CGS with a single click of the 

[Aimpoint Verification] button on the Product Generation tab within IApioneer. The CGS Aimpoint 

verification dialog will load displaying the CGS application Aimpoint Verification module. Please refer to 

the CGS User Manual to use the Aimpoint Verification module. 

9.3 ATA CHIP GENERATION 
The workflow will walk you through a series of steps to help identify, verify, validate and generate an 

Automatic Target Acquisition (ATA) Chip. Please ensure that the data discovery settings (see Data 

Discovery Directories) are pointing to the directories you will like to include in the image searching 

algorithm. You start the workflow by clicking [ATA Chip Generation] on the Product Generation tab. This 

will display a dialog that will guide you through the necessary steps to generate the ATA chip.  

Using the ATA Chip Generation Workflow: 

1. The first stage of the workflow is the Coordinates section (Figure 74). Input the latitude, 

longitude, elevation, and attack heading (optional) for the desired target location. Once you 

have provided valid data for the mandatory fields, the Image Source stage will become active. 
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2. Clicking on the Image Source stage will run a source selection process, based on your current 

Data Discovery settings, and a list of images will be displayed for the coordinates provided 

(Figure 75). The images will be highlighted to indicate the acceptance criteria for the image used 

by the wizard.  

 

 Green – The metadata parameters are all present, and all meet the requirements for an 

ATA chip.  

 Yellow – At least one of the required metadata parameters is missing.  Use at your own 

risk. 

 Red – The metadata parameters are all present, but at least one is outside the 

thresholds specified for the ATA chip process. 

Hovering over any of the images in the source selection list will pop up a tooltip, which is 

populated with all of the ATA metadata parameters for the image. This allows you to inspect the 

parameter values directly to determine the chip’s quality, based on your needs and experience. 

Select the image that you would like to use for your chip generation. The image will display in 

the viewer.  After selecting an image, the Visual Inspection group will become active.  

3. Click on the Visual Inspection group (Figure 76) and Specify the Aimpoint by clicking the four 

arrow icon pointing to the center then click in the image where you like to mark within the 

image. You can pan and zoom in the image viewer just as in any of the other IApioneer viewers. 

Once the Aimpoint has been placed at the desired location, zoom out to see the visual indicators 

for chip boundaries, cloud cover, and streaking. Validate the image as a viable chip source by 

checking the checkboxes to certify that is has no image boundaries within 1000 meters (red), no 

streaking within 1000 meters (yellow) and no clouds within 600 meters (cyan).  Once all visual 

inspection values are verified, the Generate ATA Chip stage will become active. 

4. Click the Generate ATA Chip group to create the chip from your specified parameters (Figure 

77). Click [Create it!] to display the save as dialog. The Save As Dialog will allow for you to 

specify the location of where you would like to save the file and the filename that you would like 

to provide it. Then click the Save button to process and create the ATA Chip. 
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Figure 74. Stage 1: Specify the target coordinates. 
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Figure 75. Stage 2: Select the source image. 
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Figure 76. Stage 3: Specify the aimpoint and make visual checks for artifacts. 
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Figure 77. Stage 4: Create the ATA chip. 

 

9.4 LINE OF SIGHT 
This tool will allow for the user to display a 360-degree Line of Sight (LOS) from a fixed location. The LOS 

tool uses an active 3D vector layer and a fixed point to create an annotation file that will store the area 

of view. You must ensure that you have a Vector Layer active to use the LOS tool. Click [Line of Sight] on 

the Product Generation tab to display the Line of Sight dialog.  

You can use one of two ways to obtain the Latitude, Longitude and Elevation. First, you can visual 

identify the point within the image viewers by using the Specify Camera Location. Click the four arrow 

icon pointing to the center then click within the viewer where you would like to place the fixed point. 

Second, you could manually type the Latitude, Longitude, and Elevation within the respective textbox. 

After the location has been determine you will need to identify the vison radius. The vision radius is the 

distance from the fixed point. You can manually type in the value or use the controls to increment or 

decrement the current value by 1.  

Click [OK] to process the information and display your line of sight from the fixed location. A polygon 

representing the LOS will be added to your session as a new Annotation Layer, as seen in Figure 78. 
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Figure 78. The Line of Sight tool uses a 3D model with terrain to generate 360-degree field of view annotations. 

 

9.5 TARGET GRAPHICS 
The Target Graphics tool allows the user to produce geospatially enabled target graphics according to 

joint community standards. The Target Graphics tool currently supports ingestion of a T3D file and 

exporting to a PowerPoint file. Click [Target Graphics] on the Product Generation tab to display the JDPI 

Configuration dialog, as seen in Figure 79. 
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Figure 79. The Configuration dialog to manage the JDPI data. 

The Configuration dialog provides the capability to load a valid T3D file, control the visibility of the JDPI 

attributes, and locate files that were not found in data discovery. Click [Browse] to locate the T3D file 

using a standard open file dialog. Select the JDPI that you would like to manage from the JDPIs list. 

Uncheck any field you would like to hide from document. Unchecking the JDPI will hide the target and 

associated textbox.  

Click [OK] to process the configurations and display the preview of the Target Graphic with the 3370 

template applied, as seen in Figure 80. The preview window will display the image, target marker and 

text boxes. Click Slide Manager to toggle the display of the slide manager. Click Configuration to display 

the Configuration dialog. Click [Prev] to navigate to the previous slide. [Prev] is disabled when the user 

is at the beginning of the slide deck. Click [Next] to navigate to the next slide. [Next] is disabled when 

the user is at the end of the slide deck. 
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Figure 80. JDPI Preview Tool 

The Slide Manager will allow the user to manage the contents of the slide. The user can select from a 

dropdown of available images to select as the base image of the current slide. The JDPI Manager 

displays a list of selectable JDPI items Click the name of the JDPI that you would like to manage. The JDPI 

properties update when the user selects a JDPI. The JDPI properties will allow the users to control the 

visibility of the JDPI marker, text box, optional text within the text box, and the callout line of the 

marker.  

The user must confirm the contents of each slide in the deck. Click [Next] to navigate to each slide to 

visually confirm the product. Click [Export to PowerPoint] to create a PowerPoint deck of the previewed 

slides. Only the confirmed slides export to the PowerPoint document. The standard save dialog will 

display to identify the location and file name of the document. You do not need PowerPoint, on your 

computer, to produce this file. 

 

9.6  PK LOOKUP 
This tool allows the user to select a PK Data file and quickly filter the data. The tool will update the 

source data as soon as you change any filter values. The tool currently ingests a csv version of the PK 

Data file. Click [PK Lookup] on the Product Generation tab to display the PK Lookup tool as seen in 

Figure 81. The user must configure the source dataset provided to the mappings of the search 
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parameters. The user can change the source field dropdown mapping to the destination lookup 

parameter. The example filed displays the first element of the data when the source data field changes.  

 

Figure 81. Mapping PK Data 

Click [Browse] to load the csv file that contains the PK Data. Click the Input tab to map your source file 

to the destination parameters. The data file will be loaded into the filters after the mapping is 

completed. This will allow the user to filter on valid data that is contained within the file. Changing any 

of the filter values will update the results accordingly.  
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Figure 82. Filtered PK Data 
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APPENDIX A - SHORTCUTS 
Shortcuts are keys or key combinations that users can press for quick access to actions. You can see a list 

of shortcuts in the application by clicking on File within the ribbon, click Help within the back stage and 

then clicking Shortcuts. This will display the dialog seen in Figure 83. The Tab column will identify which 

tab within the ribbon the command is associated with. The Command is the action that will be invoked. 

Shortcut(s) is the key combination that the users can press to action the command. 

 

Figure 83. The shortcuts dialog. 

 

Table 1. Complete listing of IApioneer shortcuts. 

Tab Command Shortcut(s) 

Home Add Vector Layer Ctrl+O 

Home Add Tie Point Layer Ctrl+I 

Home Add Annotation Layer Ctrl+U 

Home Layer Manager Ctrl+L 

Home Hide All Ctrl+J 

Home Brightness 0% (Normal) Ctrl+K 

Home Increase Brightness Ctrl+Up Arrow 

Home Decrease Brightness Ctrl+Down Arrow 

Home Zoom In + 

Home Zoom Out - 
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Tab Command Shortcut(s) 

Home Zoom 1:1 Ctrl+P 

Home Increase Contrast Shift+Up Arrow 

Home Decrease Contrast Shift+Down Arrow 

Home Contrast 0% (Normal) Ctrl+M 

Home Dynamic Range Adjustment Ctrl+Shift+G 

Home North Arrow Ctrl+N 

Home Grid Lines Ctrl+Shift+N 

Home Camera Lock Ctrl+Shift+L 

Home Pan Mode Ctrl+Shift+P 

Home Roam Mode Ctrl+Shift+M 

Home Jump to Location Ctrl+Shift+J 

Home Image Up Ctrl+Shift+R 

Home North Up Ctrl+Shift+T 

Home Z Up Ctrl+Shift+Y 

Home Rotate 180 Ctrl+Shift+U 

Home Left 90 Shift+Left Arrow 

Home Right 90 Shift+Right Arrow 

Home Cursor Information Ctrl+Shift+I 

FeatureXTract Draw Polygon Ctrl+Q 

FeatureXTract Draw Box Ctrl+A 

FeatureXTract Draw Ellipse Ctrl+W 

FeatureXTract Draw Circle Ctrl+S 

FeatureXTract Draw Point Ctrl+E 

FeatureXTract Draw Line Ctrl+D 

FeatureXTract Move Epipolar Ctrl+R 

FeatureXTract Move Z-Axis Ctrl+F 

FeatureXTract Move Freehand Ctrl+T 

FeatureXTract Rotate Ctrl+G 

FeatureXTract Extrude By Point Ctrl+Shift+H 

FeatureXTract Extrude By Plane Ctrl+H 

FeatureXTract Loft Feature Ctrl+Y 

FeatureXTract Split Edge Ctrl+B 

FeatureXTract Union Ctrl+Shift+O 

FeatureXTract Subtraction Ctrl+Shift+X 

Analysis Draw Rectangle Ctrl+Shift+A 

Analysis Draw Polygon Ctrl+Shift+Q 

Analysis Draw Ellipse Ctrl+Shift+W 

Analysis Draw Line Ctrl+Shift+D 

Analysis Draw Point Ctrl+Shift+E 
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Tab Command Shortcut(s) 

Analysis Add Point Marker Ctrl+Shift+F 

Analysis Add North Arrow Ctrl+Shift+B 

Analysis Separation Angle Ctrl+Shift+V 

Analysis Add Text Box Ctrl+Shift+S 

Analysis Length Ctrl+Shift+Z 

Analysis Add Targeting Circle Ctrl+Shift+C 
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INDEX 
3 

3D, 69, 71, 75 

3D viewer, 87 

flythrough, 89 

navigation, 89 

panning, 89 

rotation, 89 

zoom, 89 

A 

active layer, 52, 71, 72 

Add Annotation Layer, 51 

Add Vector Layer, 69 

affine, 21 

annotations, 51 

annotation layers, 51, 52 

creating, 51 

editing, 52, 58 

layer management, 51 

loading, 52 

properties, 59 

save, 52 

save as, 52 

ATA Chip Generation, 97 

automatic texturing, 50 

Auxiliary Viewer, 14 

B 

Backstage, 9, 51, 69 

Session, 10 

Band Info, 19 

Brightness, 13, 32 

Buffer Zone, 56 

C 

Camera group, 13 

Camera Lock, 13 

CGS Workflows, 97 

Chip from ROI, 48 

clip art, 53, 54, 94 

Color Curves, 31 

color transformations, 31 

Combine Shapes, 74, 80 

subtraction, 74, 81 

union, 74, 80 

Compass, 14 

Contact Us, 6 

By e-mail, 6 

By phone, 6 

Contrast, 13, 32 

copy, 71 

Counting Tool, 57 

Creation group, 72 

Crop, 45, 48 

Crop, Resample, and Reproject, 45, 48 

geospatial coordinates, 45 

geospatial data, 45 

Reproject, 45 

Resample, 45 

Cursor Information, 33 

D 

Data Discovery, 11, 37 

Data Layer Manager, 17, 52, 71 

Data Layers group, 17, 52, 71 

Datum, 20 

DEM, 10, 71 

Detailing group, 74, 75, 81, 82, 83, 84, 85, 86 

Digital Affine, 25 

Display, 42 

Display Format, 34 

Display group, 13, 31 

DTED, 71, 75 

E 

EGM96, 20, 35 

elevation source, 71, 75 

ellipse, 54, 95 

epipolar line, 75 

Export Data, 45 
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Crop, Resample, and Reproject, 45 

Export Raster Data, 47 

Image Chipping, 48 

Type Conversion, 47 

vector data, 49 

exterior orientation (EO), 21 

Extrude Polygon, 74, 75 

by point, 74 

planar, 74 

F 

feature extraction, 69 

FeatureXTract, 69, 71, 72, 75, 78 

fiducials, 21, 22 

Filters, 13, 32 

Gaussian High Pass, 32 

Gaussian Low Pass, 32 

Haze Reduction, 32 

High Pass, 32 

Low Pass, 32 

focal length, 21 

focal offset, 21 

Footprints, 61 

frame camera, 20 

configuration, 21 

Digital Affine, 25 

Full Screen Chip, 49 

G 

Geolocation Formats, 14, 34 

grid lines, 13, 32 

Grid Lines, 43 

gutterline, 75 

H 

Height, 55 

Hide All, 18 

Histogram, 13 

Histogram Adjustment, 31 

Home Tab, 13, 17, 52, 71 

I 

IApioneer, 51, 52 

Image Chipping, 48 

Image Gallery, 9 

Image group, 33 

image overview, 13 

Image Overview, 32 

Image Up, 14, 42 

Input Format, 35 

Insert group, 53, 94 

Inspect/Measure group, 55 

Installation, 5 

interior orientation (IO), 21 

J 

jump to location, 13, 14 

K 

Keyboard Shortcuts, 108 

KML, 90 

KMZ, 90 

L 

Layer Manager, 9, 17, 52, 71 

Left Viewer, 9 

length, 55 

Line of Sight, 102 

Load Data, 11 

Loft Feature, 74, 78 

LOS. See Line of Sight 

M 

Manipulation group, 73 

Manipulation mode, 73, 75, 76 

Measurement, 36 

mensuration, 55 

settings, 62 

Mensuration Properties, 60 

Mensuration Tools, 62 

Mesh Convert, 74 

Metadata, 19, 22 

MGRS, 34 

MIL-STD-2525B, 53 

Move Epipolar, 73, 75 

Move Freehand, 73 

Move Z-Axis, 73, 76 
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N 

New Viewer. See Auxilliary Viewer 

north arrow, 54, 95 

North arrow, 13, 32 

North Up, 14, 42 

O 

ortho. See orthographic 

orthographic, 20, 30 

Sensor Model Configuration, 30 

P 

pan, 13 

Pan Mode, 14 

parallax, 15 

parameterized structures. See Roofs and Structures 

Parameterized Structures, 81 

barrel vault, 84 

dome, 85 

fence, 86 

gabled, 81 

gambrel, 83 

hipped, 81 

mansard, 83 

parapet, 82 

pointed vault, 84 

saltbox, 81 

wall, 86 

paste, 71 

Pixel Cursor, 40 

PK Lookup, 105 

point, 54, 63, 95 

settings, 63 

point marker, 54, 58, 64, 95 

settings, 64 

polygon, 53, 60, 65, 94 

edit vertices, 58 

settings, 65 

subdivide, 58 

polyline, 54, 66, 95 

settings, 66 

Product Generation Tab, 93 

Projection, 20 

pyramids, 11 

R 

radial distortion, 21 

RASTER DATA, 12 

chipping, 48 

Exploring, 13 

Export, 45 

Properties, 19 

rectangle, 54, 94 

reduced resolutions. See pyramids 

Region of Interest, 44, 48 

Region Of Interest, 13 

Reproject, 45, 48 

Resample, 45, 48 

Reverse Face, 74 

Ribbon, 8 

File tab, 9 

Right Viewer, 9 

Roam Mode, 14 

roof shapes 

gabled, 82 

hipped, 82 

Roofs and Structures, 74 

Rotate, 74 

rotation, 14 

Rotation group, 14 

RPC, 20 

Configuration, 29 

R-sets. See pyramids 

S 

Scale Marker, 33 

settings, 41 

Scanned Film, 22 

Screen Capture, 49 

ROI, 49 

to Clipboard, 49 

to File, 49 

to PowerPoint, 49 

Sensor Model, 19 

frame camera, 20 

Frame Camera Sensor Model Configuration, 21 

orthographic, 20 

Orthographic Sensor Model Configuration, 30 

RPC, 20 

RPC Sensor Model Configuration, 29 

Setting Up Camera Sensor Models, 20 
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separation angle, 55 

Session, 10, 11, 19 

Session Management, 19 

Close Session, 19 

Open Session, 19 

Save Session, 19 

Save Session As, 19 

Settings. See User Settings 

shapes, 53, 94 

Shortcuts. See Keyboard Shortcuts 

Site Administration, 6 

snapping tool, 79 

SHIFT, 79 

Source DEM, 14, 71, 75 

Spatial Reference Systems, 20 

Configuring, 20 

Spatial Referencing dialog, 20 

Split Edge, 74 

SRS. See Spatial Reference System 

Stereo Viewer, 15 

controls, 17 

Subdivide Polygon, 58 

T 

Target, 67 

target circles, 54, 58, 95 

settings, 67 

Target Graphics, 103 

Template Editor, 93 

Terrain, 38 

text box, 54, 95 

textbox, 68 

settings, 68 

Textbox 

editing, 59 

Type Conversion, 47 

U 

UI Conventions, 5 

undo, 71 

User Interface (UI), 8 

Elements of the UI, 8 

User Settings, 33, 60 

Data Discovery, 37 

Display, 42 

Footprints, 61 

Geolocation Formats, 34 

Grid Lines, 43 

Measurement, 36 

Mensuration Tools, 62 

Pixel Cursor, 40 

Point, 63 

Point Marker, 64 

Polygon, 65 

Polyline, 66 

Region of Interest, 44 

Target, 67 

Terrain, 38 

Textbox, 68 

V 

vector data 

export, 49 

vector layers, 69 

vectors 

circle, 73 

cones, 78 

creating, 69, 75 

creation, 72 

editing, 71 

ellipse, 73 

exporting, 70 

finalize, 75 

layer management, 69 

line, 73 

loading, 71 

point, 73 

polygon, 73 

pyramids, 78 

renaiming, 70 

save, 70 

save as, 70 

selection, 76 

vector layers, 69, 71 

Viewer 

Auxilliary, 14 

divider, 13 

Send to Left Viewer, 13 

Send to Right Viewer, 13 

Visibility, 52, 71, 75 

W 

WGS84, 20, 35 
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Z 

Z Up, 14, 42 

zoom, 13 

zoom indicator, 33 

 


